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Agenda: • Introduction 

• What is Functional Safety & Safety Standards Overview 

• IEC 61508 & ISO 26262 Safety Standards 

• Safety System Architectures 

• SafeTI™ 

• Hercules Safety Concept 

• Development Tools: Hardware kits, Software tools 

• Printed Circuit Board Design Considerations 

• Lab 1: Hercules™ Safety MCU Demos 

• Hercules™ Architecture 

• Embedded Flash Memory tools 

• Real Time Interrupt (RTI)  

• Vectored Interrupt Manager (VIM) 

• Direct Memory Access (DMA) 

• General-purpose I/O (GIO) & NHET Timer Co-processor 

• Lab 2: PWM Generation using the NHET & Clock Monitor 

• Communication Interfaces: Multi-Buffered Serial Peripheral Interface (MibSPI), 

CAN, FlexRay, EMAC, USB, UART, LIN 

• External Memory Interface (EMIF) / Parameter Overlay (POM) 

• Multi-buffered Analog-to-Digital Converter (MibADC) 

• Lab 3: MibADC Light Sensor & SCI Communication  

• Additional Hercules Information: Web, Forum, WIKI & Training 



Hercules™ Software Install Instructions 
 

Required Software 
Three software titles will be used to during the lab exercises of this 

workshop: Hercules Safety MCU Demos, Code Composer Studio v5.x, 

HALCoGen  
 

Software Download & Install Location: 
• Hercules Safety MCU Demos 

• The Demo software can be downloaded here:  

Hercules Safety MCU Demos LINK 

• A standard install of the software is required  

• Code Composer Studio  
• CCS can be downloaded here:  

CCSv5 Download LINK 
• A full install (Complete Feature Set) is acceptable, but at 

a minimum a custom install where the ‘Safety MCUs’ 

processor support is selected will be necessary.  
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• HALCoGen 
• HALCoGen can be downloaded here: 

HALCoGen Download LINK 
• A standard install of the software is required 

• Select the FREE LICENSE option the first time CCS is run: 

http://www.ti.com/tool/hercules_safety_mcu_demos
http://software-dl.ti.com/dsps/forms/self_cert_export.html?prod_no=ccs_setup_5.2.1.00018.exe&ref_url=http://software-dl.ti.com/dsps/dsps_public_sw/sdo_ccstudio/CCSv5/CCS_5_2_1/
http://www.ti.com/tool/halcogen


Hercules™ Safety MCU: Introduction 
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TI Embedded Processing Portfolio 

Microcontrollers 

32-bit 
Real-time 

C2000 

 

Fixed &  

Floating Point 

 

Up to 300 MHz 

 

Flash 

32 KB to 512 KB  

PWM, ADC,  

CAN, SPI, I2C 

 

Motor Control,  

Digital Power,  

Lighting 

32-bit  
M4F ARM 

Tiva™ C Series 

 

Industry Std 

Low Power 

 

<100 MHz 

 

Flash 

Up to 256 KB  

USB, ENET,  

ADC, PWM, CAN 

 

Host  

Control 

16-bit 

MSP430 

 

Ultra-low  

Power 

 

Up to 25 MHz 

 

Flash 

1 KB to 256 KB  

Analog I/O, ADC 

LCD, USB, RF 

 

Measurement, 

Sensing, General  

Purpose  

DSP 

C55x, C64x+ 

C647x 

Leadership DSP  

Performance 

 

24,000 MMACS 

 

Up to 3 MB 

 L2 Cache 

1G EMAC, SRIO, 

DDR2, PCI-66 

Comm, WiMAX,  

Industrial/ 

Medical Imaging 

 

32-bit 
ARM+ 

ARM9 

ARM Cortex-A8 

Industry-Std  

Core,  

High-Perf GPP  

Accelerators 

 

MMU 

 

USB, LCD, 

MMC, EMAC 

Linux/WinCE  

User Apps 

 

Applications Processors / DSP 

32-bit 
ARM+DSP 

ARM9/Cortex-A8 

  plus C64x+ 

Industry-Std Core +  

DSP for Signal Proc. 

4800 MMACs/ 

1.07 DMIPS/MHz 

 

MMU, Cache 

 

VPSS, USB,  

EMAC, MMC 

Lin/Win O/S + 

Video, Imag, MM 

 

 

32-bit 
 R4F ARM` 

 Hercules™ 

TMS570/RM4 

 

Floating Point 

 
 Over 350 DMIPS 

 

Flash 

Up to 3 MB 

Timer co-proc 
ENET,ADC, CAN 

 
Safety Critical 

Transportation,  

Industrial &  

Medical 

 

ARM Core Offerings 
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TI Hercules
TM

 MCU Platform   
ARM® Cortex™ Based Microcontrollers 

RM 

Industrial and Medical 
Safety MCUs 

• Industrial Applications 

• Medical Applications 

• -40 to 105°C Operation 

• ENET, USB, CAN & UART 

• Developed to Safety Standards 

• IEC 61508 SIL-3 

• Cortex-R – over 350 DMIPs 
 

Hercules™ 
Safety MCU  

Platform 

TMS570 

Transportation and 
Safety MCUs 

• Transportation Applications 
• Automotive Q100 Qualification 
• -40 to 125°C Operation 
• FlexRay, ENET, CAN, LIN/UART 
• Developed to Safety Standards 

• ISO 26262 ASIL-D 
• IEC 61508 SIL-3 

• Cortex-R – over 280 DMIPs 

TMS470M 

Value Line Transportation  
& Safety MCUs 

• Transportation Applications 

• Automotive Q100 Qualification 

• -40 to 125°C Operation 

• CAN, LIN/UART Connectivity 

• Supports Safety for 

• IEC 61508 Systems 

• Cortex-M – to 100 DMIPS 
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Electric Power Steering 

Radar / Collision Avoidance 

(ADAS) Hybrid & Electric Vehicles 

Airbag 
Braking / Stability Control 

Chassis / Domain Control 

Active Suspension 

Anti-Skid Control 

Industrial Motor  

Control Manufacturing / 

Robotics 

Wind Power 

Avionics / Autopilot 

Industrial  

Automation / PLC 

Communications Gateway 

Sensor & Communications 

Gateway 

Solar Power 

Oxygen 

 Concentrators 

Respirators 

Anesthesia  

Motor Control 
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Aerospace & Railway Industrial 

Automotive 

Infusion Pumps 

Medical 

Flight Control 

Hercules™ Safety MCU Applications 

Elevator 

Escalator 



TI Transportation & Safety  MCU Technology 

1980’s 

1990’s 

2000 

2006 

2013 

33F12 

33F10 

18F05 

15F035 

12F021 

TMS370C8 

TMS370C16 

TMS470 

TMS570 

ARM7 

Cortex 
  M3 

Cortex 
  R4  

Cortex 
  R4F 
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TMS470M 

RM4 
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RM46L4x – 200MHz R4F 
1MB Flash, 128kB RAM 

SafeTI ISO & IEC 

RM46L8x – 220MHz R4F 
1.25MB Flash, 192kB RAM 

SafeTI ISO & IEC 

RM42x – 100MHz R4 
384kB Flash, 32kB RAM 

SafeTI ISO & IEC 

RM48L5x – 200MHz R4F 
2MB Flash, 192kB RAM 

SafeTI ISO & IEC 

RM48L9x – 220MHz R4F 
3MB Flash, 256kB RAM 

SafeTI ISO & IEC 

Next Gen Mid 

SafeTI ISO & IEC 

Features: 
Lock Step 

Architecture 
QEP/PWM 

ISO ISO 13849 IEC IEC 61508 

Ethernet 

USB 

Next Gen High 

SafeTI ISO & IEC 

Next Gen Low 

SafeTI ISO & IEC 
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Sampling 

Development 

Production 

CAN CAN 

! SafeTI 

! 

CAN 

CAN 

! 

! 

CAN 

Hercules™ RM Cortex™-R Roadmap  



Features 

RM46x 

Control Peripherals 

2x High End Timer (N2HET) 

ePWM (14ch)  

eCAP (6x) 

eQEP (2x) 

Communications 

10/100 EMAC 

USB Host & Device 

3x CAN (64mb) 

3x Multi-Buffer SPI , 2x SPI 

2x UART 

I2C 

Analog 

12-bit MibADC1 – 24ch  
(16 shared channels) 

12-bit MibADC2 – 16ch 
(16 shared channels) 

Power & Clocking 

OSC/PLL 

CLKMON 

VMON 

Safety & System 

CPU BIST 

SRAM BIST 

CRC 

OS Timers 

Windowed Watchdog 

Memory 

Up to 1.25MB 

Flash (w/ ECC) 

Up to 192KB 

SRAM (w/ ECC) 

64KB EEPROM (emulated) 

Debug 

JTAG 

Calibration 

ARM 

Cortex™-R4F 

ARM  

Cortex-R4F 
Up to 220 MHz 

Memory Protection Unit 

Temperature Range -40°C - 105°C 

Lockstep CPU Fault 

Detection 

IEC 

RM46x Block Diagram 
Dual Core Lockstep ARM Cortex-R4F w/ Floating Point 

Performance / Memory 
• Up to 220 MHz ARM Cortex-R4F w/ Floating Point  

• Up to 1.25MB Flash and 192KB Data SRAM w/ECC 

•  Dedicated 64KB Data Flash (EEPROM Emulation) 

• 16 Channel DMA 
 

Safety   
• Dual CPUs in Lockstep 
• CPU Logic Built in Self Test (LBIST) 
• Up to 12 CPU MPU regions 
• Flash & RAM w/ ECC (w/ bus protection) 
• Memory Built-in Self Test (PBIST) 
• Cyclic redundancy checker module (CRC) 
• Select peripheral RAMs protected by Parity 

Communication Networks 
• 10/100 MAC  
• USB: Host and Device 
• 3 CAN Interfaces 
• 5 SPI (3 Multi-Buffered) 
• 2 UART, 1 I2C 

Enhanced I/O Control 
• 2x High End Timer Coprocessor (N2HET) w/DMA 

• Up to 44 pins plus 6 monitor channels  
• Pins can be used as Hi-Res PWM or Input Capture 

•    Motor Control Timers 
•  7x ePWM (14 ch), 6x eCAP, 2x eQEP  

•    2 x12-bit Multi-Buffered ADC 
• 24 total input channels (16 shared)  
• Calibration and Self Test 

•    Up to 101 GPIO pins (16 dedicated) 

Packages 

DMA w/ Memory Protection Unit 

Enhanced System Bus and Vectored Interrupt Manager 

Input / Output 

GIO/INT (16) 

CAN 

144p QFP 
(20x20mm) 

337p BGA 
(16x16mm) 

Memory Interface 

SDRAM EMIF 

Targeted Applications 
 General  IEC61508 

Safety Applications  

 Industrial, Medical, 

Energy 
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Memory Power & Clocking 

Debug 

Safety & System 

Note: Above reflects max configuration of each module – some functions are multiplexed. 

Analog 

Memory Interface 

Communications 

Input / Output 

Control Peripherals 



Hercules™ TMS570 Roadmap  
2012 2014 

L
o

w
 

M
id

 
H

ig
h

 

TMS570LS11x – 180MHz R4F 
1MB Flash, 128kB RAM 

SafeTI ISO & IEC 

TMS570LS12x – 180MHz R4F 
1.25MB Flash, 192kB RAM 

SafeTI ISO & IEC 

TMS570LS03x – 80MHz R4 
256kB Flash, 24kB RAM 

SafeTI ISO & IEC 

TMS570LS04x – 80MHz R4 
384kB Flash, 32kB RAM 

SafeTI ISO & IEC 

TMS570LS21x – 180MHz R4F 
2MB Flash, 192kB RAM 

SafeTI ISO & IEC 

TMS570LS31x – 180MHz R4F 
3MB Flash, 256kB RAM 

SafeTI ISO & IEC 

             

             

Features: 
Lock Step 

Architecture 

ISO ISO 26262 IEC IEC 61508 

Ethernet 

             FlexRay 

QEP/ePWM 

2013 

Next Gen Mid 

SafeTI ISO & IEC 

Next Gen High 

SafeTI ISO & IEC 

Next Gen Low 

SafeTI ISO & IEC 
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Sampling 

Development 

Production 

CAN 

! 

CAN CAN 

! SafeTI 

CAN 

! 

CAN 
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Features 

TMS570LS31x 

Control Peripherals 

High End Timer 1 

 (N2HET1 = 32ch) 

High End Timer 2 

 (N2HET2 = 14ch) 

Communications 

10/100 EMAC 

2ch FlexRay 

3x CAN (64mb) 

3x Multi-Buffer SPI , 2x SPI 

2x UART (1 LIN capable) 

I2C 

Analog 

12-bit MibADC1 – 24ch  
(16 shared channels) 

12-bit MibADC2 – 16ch 
(16 shared channels) 

Power & Clocking 

OSC/PLL 

CLKMON 

VMON 

Safety & System 

CPU BIST 

SRAM BIST 

CRC 

OS Timers 

Windowed Watchdog 

Memory 

Up to 3MB 

Flash (w/ ECC) 

Up to 256KB 

SRAM (w/ ECC) 

64KB EEPROM (emulated) 

Debug 

JTAG 

ETM, RTP, DMM 

ARM 

Cortex™-R4F 

ARM  

Cortex-R4F 
Up to 180 MHz 

Memory Protection Unit 

Temperature -40°C - 125°C AEC Q100 

Lockstep CPU Fault 

Detection 

IEC 

TMS570LS31x/21x Block Diagram 
Dual Core Lockstep ARM Cortex-R4F w/ Floating Point 

Performance / Memory 
• Up to 180 MHz ARM Cortex-R4F w/ Floating Point  

• Up to 3MB Flash and 256KB Data SRAM 

•  Dedicated 64KB Data Flash (EEPROM Emulation) 

• 16 Channel DMA 
 

Safety   
• Dual CPUs in Lockstep 
• CPU Logic Built in Self Test (LBIST) 
• Up to 12 CPU MPU regions 
• Flash & RAM w/ ECC (w/ bus protection) 
• Memory Built-in Self Test (PBIST) 
• Cyclic redundancy checker module (CRC) 
• Select peripheral RAMs protected by Parity 

Communication Networks 
• 10/100 MAC  
• FlexRay w/DMA 
• 3 CAN Interfaces 
• 5 SPI (3 Multi-Buffered) 
• 2 UART (1 LIN capable), 1 I2C 

Enhanced I/O Control 
• 2x High End Timer Coprocessor (N2HET) w/DMA 

• Up to 44 pins plus 6 monitor channels  
• Pins can be used as Hi-Res PWM or Input Capture 

• 2 x12-bit Multi-Buffered ADC 
• 24 total input channels (16 shared)  
• Calibration and Self Test 

• Up to 120 GPIO pins (16 dedicated) 

Packages 

DMA w/ Memory Protection Unit 

Enhanced System Bus and Vectored Interrupt Manager 

Input / Output 

GIO/INT (16) 

CAN 

144p QFP 
(20x20mm) 

337p BGA 
(16x16mm) 

Memory Interface 

SDRAM/ASYNC EMIF 

Targeted Applications 
 IEC 61508 and ISO 

26262 Safety 

Applications  

 Automotive, Rail, 

Aerospace (COTS), Off 

Road 
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Memory Power & Clocking 

Debug 

Safety & System 

Note: Above reflects max configuration of each module – some functions are multiplexed. 

Analog 

Memory Interface 

Communications 

Input / Output 

Control Peripherals 

ISO 

http://www.ti.com/product/rm48l952


What is Functional Safety &  

Safety Standards Overview 

13 



International Functional Safety Standards 

EN 50128 

 (railway) 

DO-254 
DO-178B 

(cots 
aerospace) 

IEC 
50156 

(furnaces) 

IEC 60880 
(nuclear 
power 

stations) 

ISO 26262 
(automotive) 

IEC 62061 
ISO 13849 
(machinery) 

IEC 
61511 
(process 
industry) 

IEC  
60601 
(medical 

equipment) 

IEC 61508 

(safety) 

 Safety critical systems are everywhere 

 Systems need to manage hazardous failures 

 Many systems need to be safety-certified  
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Automotive and 
Transportation 

Industrial and 
 Medical 

HEV/EV Cars 

Aerospace Systems 

Radar / Collision  
Avoidance (ADAS) 

Active suspension, ABS, 
electric power steering,  

airbag and more! 

Railway Systems 

Manufacturing, robotics, 
industrial automation, 

motor control 

Wind & Solar Power 

Anesthesia machines,  
respirators, ventilators,  
oxygen concentrators 

Sensor &   
communications  

gateway 

Hercules 
Safety MCU  

TM 



What is Functional Safety? 
• Basic Functional Safety Concepts:   

– All systems will have some inherent, quantifiable failure rate.  It is not possible 

to develop a system with zero failure rate. 

– For each application, there is some tolerable failure rate which does not lead 

to unacceptable risk. 

– Acceptable failure rates vary per application, based on the potential for direct 

or indirect physical injury in the event of system malfunction. 

– Categories can be developed to quantify similar levels of risk.  These are 

known as Safety Integrity Levels, or SILs. 
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DO-254 
Design Assurance Levels 

B 

A 

C 

D 

E 

IEC 61508 
SIL Levels 

1 

2 

3 

4 

ISO 26262 
ASIL Levels 

A 

B 

C 

D 

QM 
Quality Managed 



Functional Safety Definitions 

IEC 61508 Definition: 

– Safety is the freedom from unacceptable risk of physical injury or of 

damage to the health of people, either directly, or indirectly as a 

result of damage to property or to the environment. 

– Functional Safety is part of the overall safety that depends on a 

system or equipment operating correctly in response to its inputs. 

 

ISO 26262 Definition:   

– Absence of unacceptable risk due to hazards caused by mal-

functional behavior of electrical and/or electronic systems 

16 



Other Safety Concepts & Definitions 
• Fault: 

– Operational issue in a system which may lead to a failure. 

• Failure: 
– Result of a fault which leads to an inability to execute safety critical functionality 

• Fault Tolerance : 
– Ability to continue safe operation after a fault.   

• Fail Safe System:  
– System where a fault which may lead to failures is detected and the system is put into a safe state 

such that faults may not propagate to other systems 

• Fail Functional/Operational System: 
– System where a fault which may lead to failures is detected and the system can continue 

operation without loss of safety function. 

• Reliability 
– Ability to execute operations in system without failure (generally independent of consideration for 

a safety function) 

• Availability 
– Amount of time in which a safety function is available divided by total system operation 

time.  Systems with high reliability and fail functional systems tend to have higher availability than 

fail safe systems 

• Security 
– Ability to detect, resist, or prevent tampering with product functionality. 
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Safety Failures and their Causes 

• Failures in a functional safety system can 

be broadly classified into two categories:  

Systematic and Random failures 

Failures 

Systematic Random 

• Systematic Failures 

– Result from a failure in design or manufacturing  

– Often a result of failure to follow best practices 

– Rate of systematic failures can be reduced through continual and 

rigorous process improvement 

 

• Random Failures 

– Result from random defects inherent to process or usage condition 

– Rate of random failures cannot generally be reduced; focus must be 

on the detection and handling of random failures in the application. 

Note: Software failures are considered to be systematic 

18 



Functional Safety vs. Quality/Reliability 

• High quality and reliability do not guarantee safety.   

 

• Methods to ensure quality and reliability have high overlap to methods 

used to manage systematic safety failures. 

 

• Requirements to manage safety of random hardware failures in 

applications typically do not overlap quality, reliability and security 

requirements. 
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When faced with a potential system over temperature fault that causes 

wiring to melt resulting in a system failure: 

− A reliability engineer  would approach the problem by designing the 

system with high temperature wiring 
 

− A functional safety engineer would approach the problem by designing 

the system to detect the over temperature condition and placing the 

system into a safe state before the wiring could melt. 

 



Functional Safety vs. Security 

• A secure system is capable of detecting, resisting or 

preventing tampering from the outside world  
 

• A functionally safe system is capable of detecting faults 

and preventing damage to the outside world 
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Secure System: 

Avoids system manipulation from the 

outside world 

Functional Safe System: 

Does not create an unacceptable risk 

to the health of people, the system or 

the environment 



Safety Goals 

• Safety Goals must defined for a safety system 
 

– Example: Automotive Air Bag System: 

• Air bag must deploy in the event of an accident 

• Air bag must not inadvertently deploy when there is not an accident.  

 

• Safety goals are used to help determine the level of functional safety is 

necessary in a system. 

 

• These safety levels are usually referred to as Safety Integrity Levels or 

SILs. 

 

• Different safety standards have different metrics and naming  

classifications for SILs. 
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ISO 26262 vs IEC 61508 Safety Integrity Levels 

• ISO 26262 was developed to 

meet automotive industry 

specific needs as replacement 

for IEC 61508. 

 

• IEC 61508 defines 4 safety 

integrity levels (SIL-1,2,3,4) 

 

• ISO26262 defines a Quality 

Managed level in addition to 4 

safety integrity levels          

(ASIL-A,B,C,D)  

 

• There is no direct correlation 

between IEC61508 SIL and ISO 

26262 ASIL levels 

 

 

 

 

 

 

IEC 61508 

SIL Levels 

1 

2 

3 

4 

ISO 26262 

ASIL Levels 

A 

B 

C 

D 
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QM 
Quality Managed 



Aerospace DO-254 Design Assurance Levels 
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• DO-254 Consists of 5 ‘Design Assurance Levels’ (DALs) 

• DAL-A is the most stringent, DAL-E is the least 

• An FAA ‘Designated Engineering Representation’ (DER) must audit & 
approve 

DO-254 
Design Assurance Levels 

B 

A 

C 

D 

E 

IEC 61508 
SIL Levels 

1 

2 

3 

4 

ISO 26262 
ASIL Levels 

A 

B 

C 

D 

QM 
Quality Managed 



• To determine the ASIL level of a system a Risk Assessment must be 

performed for all Hazards identified. 

• Risk is comprised if three components: Severity, Exposure & Controllability 

 

Hazard 

Causal Factorn 

Risk = S x (E * C) 

Causal Factor1 

Safety Goal1 

Safety Goaln 

Accident 

Determining ISO 26262 ASIL Level 
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S = Severity 

E = Exposure 

C = Controllability 

Class Description 

E0 Incredible 

E1 Very low probability 

E2 Low probability 

E3 Medium probability 

E4 High probability 

Class Description 

C0 Controllable in general 

C1 Simply controllable 

C2 Normally controllable 

C3 Difficult to control or uncontrollable 

Class Description 

S0 No injuries 

S1 Light and moderate injuries 

S2 Severe and life-threatening injuries (survival probable) 

S3 Life-threatening injuries (survival uncertain), fatal injuries 



ASIL Determination Table 

Controllability 

Severity Exposure C1Simply C2 Normal C3 Difficult 

S1 
Light and moderate injuries 

E1 Very Low QM QM QM 

E2 Low QM QM QM 

E3 Medium QM QM ASIL A 

E4 High QM ASIL A ASIL B 

 

S2 
Severe and life-threatening 

injuries (survival probable) 

 

E1 Very Low QM QM QM 

E2 Low QM QM ASIL A 

E3 Medium QM ASIL A ASIL B 

E4 High ASIL A ASIL B ASIL C 

S3 
Life-threatening injuries 

(survival uncertain), fatal 

injuries 

 

E1 Very Low QM QM ASIL A 

E2 Low QM ASIL A ASIL B 

E3 Medium ASIL A ASIL B ASIL C 

E4 High ASIL B ASIL C ASIL D 
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Risk = Severity x (Exposure * Controllability) 



ISO 26262 Failure Rates 

λSPF    –  Single Point Faults 

λRF      –  Residual Faults 

λMPFDP –  Detected/Perceived Multi Point Faults 

λMPFL   –  Latent Multi Point Faults  

λMPF    –   λMPFDP + λMPFL = Multi Point Faults 

λS        –  Safe Faults 

26 

FIT = Failures In Time = 1 failure in 109 device hours 

Failure Rate λ  

λ  =  λSPF  + λRF + λMPF  + λS 

Hardware Failure Modes 

Non Safety Related Safety Related 

Safe Fault 

Residual /  

Single 

Point Fault  

Latent 

Multiple 

Point Fault 

Perceived 

Multiple 

Point Fault 

Detected 

Multiple 

Point Fault 

Safe Fault 



Fault Metrics 

• Minimize single point and residual faults. 

 Detected and handled by system within system safety response time. 

Metric ASIL B ASIL C ASIL D 

Single point fault metric 

• Minimize latent multi point faults. 

 Detected and handled within hours through test algorithms. 

Metric ASIL B ASIL C ASIL D 

Latent fault metric 
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IEC 61508 Failure Rates 

• λS – Safe failure rate 

– No impact on safety function 

– λSD – Safe detected failure rate 

– λSU – Safe undetected failure rate 

 

• λD – Dangerous failure rate 

– Impact on safety function 

– λDD – Dangerous detected failure rate  

– λDU – Dangerous undetected failure rate 
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FIT = Failures In Time = 1 failure in 109 device hours 

Failure Rate λ  

λ = λS + λD = (λSD + λSU) + (λDD + λDU) 



IEC 61508 Safe Failure Fraction & SIL 
Determination 
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Safe Failure Fraction (SFF) = 1 – 
λDU 

λ 

Safe Failure Fraction 
(High Demand System) 

Hardware Fault Tolerance 

HFT = 0 HFT = 1 

0 … < 60 - SIL1 

60 … < 90 SIL1 SIL2 

90 … < 99 SIL2 SIL3 

≥ 99 SIL3 SIL4 

High Demand System 

Hardware Fault Tolerance = 0 (single channel) 

• 1 Fault may lead to loss of safety function. 

Hardware Fault Tolerance = 1 (redundant) 

• 2 or more faults needed to loss of safety function. 



Safety System Architectures 
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• There are numerous system architectures 

designed for functional safety.  This section 

describes a few of the most common, but is not 

exhaustive. 

 

• General terminology is “XooY” 

– X out of Y 

– X out of Y total units must fail for total system to fail 

 

Safety System Architectures 
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1oo1 Processing Architecture 

• “One out of One” subsystem failure creates system failure 

• Most minimal system configuration possible 

• No internal diagnostics 

• No fault redundancy 

32 

Sensor 

Embedded  

Processor Output 

Circuit 

+ 

Actuator 



1oo2 Processing Architecture 

• “One out of Two” subsystems must fail for system to fail 

• Two controllers with independent I/O 

– Both controllers must command an output for output to occur 

– Failure in both systems required for inadvertent activation 

• Often implemented in airbag systems with a 32b main MCU and an 8b 

secondary MCU used to energize squib charges 
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Sensor 

Embedded  

Processor 

Output 

Circuit 

Sensor 

Embedded  

Processor 

+ 

Actuator 



2oo2 Processing Architecture 

• “Two out of Two” subsystems must fail for system to fail 

• Each system can energize the output 

– Used when it is undesirable for output to be de-energized 

– Fault tolerant of open circuit faults in either subsystem 
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1oo1D Processing Architecture 

• Expansion of 1oo1 system to include a diagnostic channel 

• Diagnostic channel can inhibit system output if a failure is detected in the 

functional system 

• Additional failure rate potential due to failure in the diagnostic circuits 

(annunciation failure) 

• TI Hercules “lockstep” processor implementations are a 1oo1D system 
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2oo3 Processing Architecture 

• 2 out of 3 subsystems must fail before system fails 

• Used in many fail operation/fail tolerant systems 
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 

2oo2D Processing Architecture 

• Effectively a 2oo2 system where each channel is a 1oo1D system 

• Provides a single level of fault tolerance 

– Upon single channel failure the system reverts to a 1oo1D system 

– Provides high fault detection rates 
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SafeTI™ 
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TI’s SafeTI™ design packages for functional 
safety are robust and help speed certification  

Standards-specific SafeTI 
solution bundles 

www.ti.com/safeti  

39 

http://www.ti.com/safeti


SafeTI™- Safety Development Process 

TI follows a development flow to  

TS-16949 that is internally and externally audited annually 

SafeTI-26262 devices 

are developed per the 

ISO 26262:2011 

requirements 

SafeTI-61508 devices 
are developed per the 

IEC 61508:2010 
requirements 

SafeTI development process has been externally 
assessed & certified 

40 
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SafeTI™ Development Process Certification by TÜV SÜD  

• TÜV SÜD is an internationally 
recognized and accredited 
independent assessor of compliance 
to quality, safety, and security 
standards. 

 

• TÜV-SÜD has certified the functional 
safety development process for 

• SafeTI-61508 

• SafeTI-26262 

 

• The certification demonstrates TI’s 
commitment to have a process 
suitable for developing hardware 
components that are compliant to 
ISO 26262 and IEC 61508 
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Hercules Safety Documents 
• Documents provided by TI some under NDA to assist in the 

safety certification process: 

– Safety Case Report (SCR) 
• Summary of compliance to IEC 61508 and/or ISO 26262 

 

– Detailed Safety Analysis Report (SAR2) 
• Full details of all safety analysis executed down to MODULE level for 

IEC 61508 and ISO 26262 

 

– Safety Analysis Report Summary (SAR1) 
• Summary of FIT rate and FMEDA at DEVICE level for IEC 61508 

and ISO 26262 

 

– Hercules TMS570/RM Device Safety Manual (SM) 
• Details product safety architecture and recommended usage 

 

NDA 

NDA 

NDA 



SafeTI™ Compiler Qualification Kit 

• Assists in qualifying the TI ARM C/C++ 
Compiler to functional safety standards 

• Model-based tool qualification methodology 
developed by Validas 

• Assessed by TÜV Nord to comply with both 
IEC 61508 and ISO 26262 

 

• Includes: 

• Qualification Support Tool  

• Documentation: 

• Tool Classification Report 
• Tool Qualification Plan 
• Tool Qualification Report 
• Tool Safety Manual 

• ACE SuperTest qualification suite  

• TI compiler validation test cases 

• Test Automation Unit (TAU) 

• 24hrs of Validas consulting services 

http://www.ti.com/tool/safeti_cqkit  

TI ARM Compiler 

IEC 61508 
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Approved by 

ISO 26262 
NOTE: There is a fee for this kit. See the web site listed below for more details. 

http://www.ti.com/tool/safeti_cqkit


The SafeTI™ Diagnostic Library: Hercules Safety MCUs 

Integrated interface for 

SafeTI™ Design Package 

companion 

PMIC/Watchdog 

(TPS6538x) 

communication  
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Periodic diagnostics 

I/O diagnostics 
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watch dog 
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SafeTI Diagnostic Library 

Hardware Abstraction Layer (HALCoGen/MCAL) 

10110000111000100010001110110001000011101001010101        

 101001010100001110110100100110010110 

                1000101010010100101 

Functions map 

directly to the 

Hercules 

Safety Manual 

http://www.ti.com/tool/safeti_diag_lib 

Power Management 
TPS65381 

Provides simple interfaces and a 

framework for 

– Initializing and Enabling  Safety 

diagnostics/Features prescribed 

by the Hercules Safety Manual. 

– Fault injection to allow testing of 

application fault handling 

– Error Signaling Module (ESM) 

handler callback routine. 

– Profiling for measuring time 

spent in diagnostic test/fault 

handling 

 

http://www.ti.com/tool/safeti_diag_lib
http://www.ti.com/tool/safeti_diag_lib


Hercules RM46x MCU 

Speed 

Ref PWM 

Torque/Flux 

Ref 

ADC 1 

Phase  

Currents Phase 
Currents 

Phase 

Currents 

eQEP 

eCAP 
Angle 

Hall  

Sensor 

Encoder  

Angle 

Motor  

Sensors 

Core &  

I/O Voltage 

PWM 

Enable 
Reset 

Error Signal 

SPI 
Resolver 

PWM (x6) 

3x 

Angle 

Check 

& 

Select 

Angle (SMO) 

SafeTI™ Motor Control Example 

FOC Software Control Loop 

Speed 

Torque 

PID 

ADC 2 

ADC 

Check 

PWM 

DCBus V 

SMO  

Angle 

Estimation 

DCBus V 

Torque  

Flux Speed 

FDBK 

Speed 

Estimation 

Angle 

High-end 

Timer 
PWM  

FDBK 

PWM 

Check 
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MOSFETs 

Typical Flow 

DRV3201 Bridge Driver 

Bridge 

Err Mon 

Current  

Monitor 

Diagnose 

Safety Flow 

eTPWM 

TPS65381 Power Supply & Safety Companion  

LBIST 

ABIST 

3.3V 

1.2V 

5.0V 

Error Mon Watchdog 
OSC Mon 

Temp Mon 

Temp 

Monitor 

Voltage 

Monitor 

Hercules RM46x MCU 

DRV3201 Bridge Driver 

TPS65381 Power Supply & Safety Companion  

Links to Product Web Pages: 

http://www.ti.com/product/rm46l852
http://www.ti.com/product/drv3201-q1
http://www.ti.com/product/tps65381-q1
http://www.ti.com/product/rm46l852


Safety Designers Count on SafeTI™ 

TI’s 20+ years of Designing Solutions for Safety 

Markets help provide: 
 

• Embedded Processing + Analog solutions that work 

together 

• Functional Safety integrated in device hardware 

• Tools and Software prepared for safety 

• Comprehensive Safety Documentation 

 

 Enable faster and easier customer Safety Certification 
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Hercules™ Cortex™-R4F Safety Concept 
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Rationale of the Hercules™ Safety Concept 

• “Safe Island” approach 

 
• Region of device common to all safety functions is heavily protected by 

hardware diagnostic measures 

– CPU 

– CPU Interrupts 

– System control of power, reset, clock 

– OS critical IP: DMA, OS timer 

 
• Once a known safe region can be guaranteed, logic in this region can 

be used to provide diagnostic coverage on other regions 

 
• This partition has shown to give strong safety metrics while minimizing 

impact of safety on system BOM cost 
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Hercules Cortex-R4F MCU safety features 

• Safe Island Hardware diagnostics (RED) 

• Blended HW diagnostics (BLUE) 

• Non Safety Critical Functions (BLACK) 

 

Dual Core Lockstep - 

Cycle by Cycle CPU 

Fault Detection 

ECC for flash / RAM / 

interconnect evaluated 

inside the Cortex R4F  

Parity on all 

Peripheral, DMA and 

Interrupt controller 

RAMS  

Memory BIST on all 

RAMS allows fast 

memory test at 

startup 

CPU Self Test 

Controller requires 

little S/W overhead 

IO Loop Back, ADC 

Self Test, … 

Error Signaling 

Module w/ External 

Error Pin 

On-Chip Clock and 

Voltage Monitoring  

Logical / physical 

design optimized to 

reduce probability of 

common cause 

failure 

PBIST/LBIST OSC PLL 

POR 

CRC RTI/DWWD 

ESM 

Enhanced System Bus and Vectored Interrupt Module 

DMA 

Memory 

Flash  
w/ ECC 

Embedded Trace 

  RAM  
w/ ECC 

Power, Clock, & Safety 

Memory Interface 

JTAG Debug 

Calibration 

Serial 

Interfaces 

Network 

Interfaces 

 Dual 

ADC 

Cores 

Available 

Dual  

High-end 

Timers 

Available 

GIO 

Flash 
EEPROM w/ ECC 

CPU Fault Detection 

Parity or CRC in 

Serial and Network 

Communication 

Peripherals  

Dual ADC Cores with 

shared channels 
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1oo1D Dual Core Safety Concept 

• Unique design to reduce common 
cause failures  

– Second CPU mirrored and 
rotated 

– Cycle delayed lockstep 

– Guard ring per CPU 

– Duplicated clock tree per CPU 

 

 

• CPU Compare Module (CCM) 

– Self-test capability 

– Self-test error injection/error 
forcing 

– Output error injection 

Output + Control 

Cycle Delay 

CCM 

Compare 

Error 

Input + Control 

Self 

Test 

50 

 
ARM® 

Cortex™-R4F 
 

Cycle Delay 



51 

STC  

ROM 

Clock 

controller 

ESM 

PCR 

Test 

controller 

ERR 

ROM 

   interface 
 

FSM 

  Clock cntrl 

STC BYPASS/ 

ATE Interface 

REG Block 

& 

Compare 

Block    

• Provides High Diagnostic Coverage  

• Significantly Lowers S/W and Runtime Overhead  

• No SW BIST (Built In Self Test) Code overhead in Flash 

• Simple to configure and start BIST via register 

CPU Self Test Controller (STC/LBIST) 

 
ARM® 

Cortex™-R4F 
 

DBIST 

CNTRL 

DBIST 

CNTRL 

VBUS 

Interface 
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Programmable Memory BIST (PBIST) 

• All on-chip RAMS can be tested 

 
• Simple register setup and 

configuration 

 
• Typically run at startup, but can 

be executed during the 
application 

 
• Multiple Memory Test Algorithms 

 
• Detects multiple failure modes 

PBIST 

Controller 

Data  

Logger 

Ext 
block 

Cfg 
block 

VBUS I/f 

Tester I/f 
RAM 

Data  

path/ 

Collars 

To / From 

Memories 

(RAM  

groups) 

ROM 
block 

ROM I/f  

Functional  

Read/Write  

Datapath 

• Provides a mechanism to determine if runtime faults were caused by hard or soft error.  

This capability can be used to improve availability through inline recovery from soft error. 
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Flash / RAM ECC Protection 

Cortex-R4 

Flash RAM 

• ECC evaluated in the Cortex R4 CPU 

– Single Bit Error Correction and Double Bit Error Detection (SECDED) 

– ECC evaluated in parallel to processing data/instructions 

– No latency or performance impact 

– Protects Busses from CPU to Flash and RAM 

4 ECC Bits 
32 Data Bits 

32 Data Bits 

64 Inst. 

8 ECC 

ECC Logic 

8 Stage  

Pipeline 

Error 

64 Data 

8 ECC 

4 ECC Bits 
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Safety Aspects of Network Interfaces 

• Networked peripherals (Ethernet, FlexRay, DCAN, and SCI/LIN) are 
considered grey-channel / black-channel communications 

 

 

• In such communications application level protocols (time redundancy, CRC in 
data packet, etc.) are necessary 
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Error Signaling Module (ESM) 

ESM 

Errors for Group 1 

Errors for Group 2 

Errors for Group 3 

To Interrupt  

Manager 
INTEN INTLVL 

Low Level Interrupt 

Handling  

High Level Interrupt 

Handling  

nERROR pin 

ERROR 

SIGNAL 

CONTROL 

LOW TIME  

COUNTER PRELOAD 

LOW TIME  

COUNTER 



Clock Monitoring 
• External clock prescaler (ECLK) 

• Allows external monitoring of CPU clock frequency 
• Configurable pin (GIO or ECLK) 

• Oscillator monitor 
• Detects failure if oscillator frequency exceeds defined min/max thresholds 
• Selectable hardware response on oscillator fail 

– Reset device 
– Switch to internal ‘low power oscillator’ (LPO) clock source 

• FMPLL slip detector 
• Indicates PLL slip if phase lock is lost 
• Selectable hardware response on PLL slip 

– Reset device 
– Switch to internal ‘low power oscillator’ (LPO) clock source  
– Switch to external oscillator clock source 

Bypass on Slip 

Input from 

Oscillator 

 

 

FMPLL 

 

 

BPOS 

Slip 

Detector 
Reset on Slip 

To Device Reset 

CLK Signal to 

CLK Control Module 

LPO 

BPOS 

ROS 
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Dual Clock Comparator (DCC) 
• The DCC module is used to measure the frequency of a clock signal 

using a second clock signal as a reference. 
• Allows application to ensure that a fixed frequency ratio is maintained 

between two clock signals 

• Supports the definition of a programmable tolerance window in terms of 

number of reference clock cycles 

• Supports continuous monitoring without requiring application intervention 

• Alternatively can be used in a single-sequence mode for spot measurements 

• Flexible clock source selection for Counter 0 and Counter 1 resulting in 

several specific use cases 

PLLMUL 
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ERROR 
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Digital Windowed Watch Dog (DWWD) 
• The DWWD module will reset the MCU or generate a non maskable interrupt to 

the CPU if the application fails to service the watchdog to within the appropriate 

time window. 
• Optional safety diagnostic that can detect a runaway CPU 

• Includes a 25-bit down counter 

• Alerts the Error Signaling Module when a CPU interrupt is generated 

• Supports multiple service windows: 100%, 50%, 25%, 12.5%, 3.125% 

• Servicing requires a specific two part key sequence 

• Once enabled can only be disabled by a system or power on reset 

•PLLMUL 
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• Bus masters include the CPU, 
DMA, HTU and the FTU 

 
• A memory region is defined which 

allows read and write access for 
the bus master 

 
• Access outside the defined region 

can be any of the mode 
 

• Read Only: Read access allowed for 
the memory accesses outside the 
region. Write accesses are blocked 
 

• No Access: Read and write access is 
blocked. 

 
• In the event of a memory 

protection violation an error is 

indicated 
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Memory Protection Unit (MPU) 
• A Dedicated Memory Protection Unit (MPU) is implemented for select bus masters 

CPU Fault 

Detection 

POR OSC PLL 

PBIST 

LBIST RTI 

CRC 

Enhanced System Bus and Vectored Interrupt Management 

DMA 

Memory 

Flash w/ ECC 

Embedded Trace 

RAM w/ ECC 

Power, Clock, & Safety 

Memory Interface 

EMIF  

Memory Protection 

JTAG Debug 

Calibration 

ARM® 

Cortex™-

R4F 
160MHz 

ARM® 

Cortex™-

R4F 
160MHz 

Timers / IO 

MibSPI 
128 Buffers; 4 CS 

Serial I/F Network I/F 

CAN1 (64mb) 

2 ch FlexRay  
8K Message RAM 

ADC 

MibADC1 
64 Buffers 

12-bit,  16ch 

(8ch shared) 

GIOB (8) 

CAN2 (64mb) 

CAN3 (32mb) MibADC2 
64 Buffers 

12-bit,  16ch 

(8ch shared) 
UART1 (LIN1) 

High End 

Timer 
(NHET) 

128 words, 

32 ch MibSPI 
128 Buffers; 4 CS 

MibSPIP 
128 Buffers; 4 CS 

GIOA/INTA (8) 

UART2 (LIN2) 

DMA 

High End 

Timer 

Transfer Unit 

(HTU) 

FlexRay 

Transfer Unit 

(FTU) 

ARM® 

Cortex™-

R4F 
 

Lockstep 

CPUs 

  



60 

Dual Analog to Digital Converters 

• Dual12-bit ADC Cores: 

 
- MibADC 1 supports dedicated analog 

inputs & shared inputs with MibADC 2 

 

- Up to 16 analog channels can be 
shared between the 2 cores for safety 
critical conversions/comparison  

 

- Internal ADC reference voltages can be 
used to check converter functionality. 

 

- Self Test Mode enables in application 
detection of opens/shorts on ADC 
inputs 

 

- ADC calibration logic can improve 
accuracy or be used to detect drift 
between multiple test results. 

 

VccAD 

VssAD 

VrefHi 

VrefLo 
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AD1EVT 

AD2EVT 

AD1IN[7..0] 

AD2IN[15..0] 

MibADC1 
AD1IN[23..8] / 

MibADC2 

Self-Test & Calibration 

Self-Test & Calibration 

Note: Not all Hercules MCUs are available with dual ADCs 
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Voltage Monitor 

• Supply Voltage Monitor (VMON) 

 

– Holds reset until core and I/O rails in expected range (removes power 
sequencing requirements) 

 

– Asserts reset if core or I/O supply exceeds defined min/max 
thresholds 

 

– Asserts reset when core supply is below specified min voltage and 
asynchronously sets all I/O pins to high impedance mode 

+ 
- 

 
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Exida Has Certified TMS570LS20216S                 
IEC 61508 SIL 3 Capable 

• Future Hercules TMS570 and RM 
products are planned to be assessed 
by Exida and/or TÜV-SÜD 

 

• To get a Safety Certificate, Hercules 
MCUs are assessed for: 

– Development Process 

– Product Safety Architecture/Concept 

– Silicon 

 

• TI has chosen to work with TÜV-SÜD 
(DAkkS accredited) and Exida (ANSI 
accredited) for both IEC 61508:2010 
and ISO 26262:2011 

 



HerculesTM Safety MCUs Provides Developers 

Protection against random and systematic failures 

Headroom for application differentiation 

Simplified development and system certification 

Hercules MCUs 

provide developers 

of safety-critical 

applications: 
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Safety Certification & Documentation Application Headroom Hardware Safety Architecture 

Over 350 DMIPs of 

processing power 

• Lockstep CPUs 

• CPU & RAM Built-in Self Test 

• Flash & RAM ECC 

• Clock Monitoring 

• Voltage Monitoring 



Hercules™ MCU Development Tools 
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Hercules™ IDEs, Compilers and RTOS Support 

• TI Code Composer Studio – compiler 

qualification kit 

 

• Embedded Workbench for ARM is 

certified by TÜV SÜD as suitable for 

use to IEC 61508 and ISO 26262 

 

• MDK-ARM with uVision IDE and ARM 

C/C++ Compilation Tools 

 

• MULTI IDE and Green Hills Compiler 

certified to ISO 26262 and IEC 61608 

 

• Tantino-Cortex-R4 with professional 

HiTOP Debugger/IDE 

 

• CoDeSys programming system and 

runtime system for IEC 61131-3 

programmable logic controllers 

 

• TargetLink code generation from 

MathWorks Simulink/Stateflow,  

certified for IEC 61508 

 

• Processor-In-the-Loop (PIL) with 

MathWorks Simulink 

 

• HET IDE with Synapticad 

WaveViewer or WaveFormer Pro 

 

 

IDEs & Compilers 
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RTOS Support 
  

•  FreeRTOS:  FreeRTOS.org 

Portable, open source, royalty free, mini 

Real Time Kernel. 

 

•  SafeRTOS: High Integrity Systems 

Design assurance package for IEC61508, 

others  

 

•  µC/OS: Micrium 

Certifiable design package for IEC61508, 

others 

  

•  SCIOPTA:  SCIOPTA RTOS  

Kernel certified by TUV for IEC 61508  

and EN50128 Hercules to SIL-3 

 

• CODESYS:  Smart Software Solutions 

Control and safety runtime system  for 

Industrial PLCs 

 

• SMXRTOS: Micro Digital 

Modular RTOS that meets the needs of 

small to medium-size embedded systems 

 

• AUTOSAR OS/RTE: 

- Vector MICROSAR Safe 

- ElektroBit tresos 

- ETAS RTA-OS & RTA-RTE 

- TI MCAL available for AUTOSAR v4.0.3 

 

 

http://www.mathworks.com/index.html


Hercules™ MCU Software Tools 

Demos, Libraries & Example Code  MiddleWare 

• MISRA-compliant embedded TCP/IP stack 

that supports both IPv4 and IPv6 protocols. 

• USB Host & Device, File systems, etc… 
 

• MISRA-compliant CANopen real-time 

protocol and device driver used in medical 

automation and automotive equipment.  

 

• Ethernet Driver and light weight IP Stack 

 
• USB Device Driver & CDC Class 

 

• Many MiddleWare options available from 

RTOS providers 
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lwIP 

USB 

Safety MCU Demos 
• Safety Feature Highlight 

• Ambient Light & Temperature Demo 

• LED Light Show 

• Maze Game 

• Source Code Viewable via CCS 

HALCoGen 
• User Input on High Abstraction Level 

• Graphical-based code generation 

• Easy configuration 

• Quick start for new projects  

• Supports CCS, IAR, KEIL & GHS 

IDEs 

Motor Software  
• InstaSPIN-BLDC MotorWare™ Project 

• Sensored FOC with redundant SMO 

MotorWare™ Project 

Libraries 
• DSP & Math Library: Optimized for 

ARM® Cortex-R4 & CMSIS Compliant 

• SafeTI™ Diagnostic Library: 

Executable form of the safety manual 

Automated offline Programmers: 

• Data I/O 

• BP Micro Systems 
 

 

In Circuit JTAG Programmers: 

• SMH Technologies 

• Checksum 

• XJTAG 

• CCS UniFlash 

 

Flash Programming 

Example Code 
• Hercules Code Repository WIKI 

http://dataio.com/en-us/industries.aspx
http://www.checksum.com/default.asp
http://processors.wiki.ti.com/index.php/Category:HerculesSWExamples
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Code Composer Studio 

• Based on Eclipse industry standard 

for embedded debug tools 
– Modern window environment 

– Advanced source code editor 

– Scalable multi-core/processor environment 

– Program and Debug Application via JTAG 

– Test Automation via Scripting 

– Available for Windows & Linux 
 

• Support across TI’s Embedded 

Processing Portfolio 
– MSP430 

– Stellaris/Tiva 

– C2000 

– Hercules 

– C5000 & C6000 DSP 

 

• Hercules™ Debug Features 
– 6 Hardware Breakpoints 

– Unlimited Software Breakpoints 

– Integrated Flash Programming 

http://www.ti.com/tool/ccstudio  

CCS Licensing Options 
–  Evaluation: Free, time limited licences for evaluation 

–  Node Locked: Tied to a specific computer 

–  Floating: Can be shared across multiple  

–  Free/Dev Kit: Can be used with Hercules kits w/ XDS100 emulators 

 

http://www.ti.com/tool/ccstudio
http://www.ti.com/tool/ccstudio
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Code Composer Studio Components:  
 

Source Code View 

Target Connection 

 Source & object files 

 File dependencies 

 Compiler, assembler 
& linker build 
options 

Disassembly 

Window 

CPU 

Window 
Memory 

Window 

Menus and Icons Help 

Watch 

Window 
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HALCoGen: Hardware Abstraction Layer Code Generator 

Features 
• User Input on High Abstraction Level 

• Graphical-based code generation 

• Easy configuration 

• Quick start for new projects  
 

• Generates C Source Code  
• ANSI Conforming 

• Clear, structured, coding style 

• Customizable code for user maintenance 
 

• Supported Drivers 
• System Modules 

• Safety Init, MPU, PMU, PMM, PCR 

• LBIST, PBIST, VIM, ESM, CRC 

• EMIF, POM, DMA, PINMUX 

• Peripheral Modules 

• RTI, GIO, ADC 

• SCI/LIN, CAN, MIBSPI / SPI, I2C 

• USB, Ethernet 

• Timer Co-processor (NHET) 

• eCAP, eQEP, ePWM 
 

• Interactive Help System 
• Describes tool features and functions  

• Provides detailed dependency graphs 

• Provides useful example code 

• Tool tip help available 
 

• Native support for CCS, KEIL, IAR 

and GHS IDEs 
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NHET Timer Co-Processor Development Tools 

• Graphical Programming Environment 

• Output Simulation Tool 

• Generates CCS-ready software modules 

• Includes functional examples from TI 

• Graphical Waveform Viewer 

• Input Generation Tool 

• Seamless interface to coding tool 

• Upgradable to Full SynaptiCAD 

NHET ASM 

Code 

Pin 

Selection 

Algorithm 

Library 

Drag & Drop 

Instructions 

Waveform 

View 

NHET  

Registers 
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Hercules
TM

 Development Kit Overview 

SafeTI™-HSK Motor Control Kit 

LaunchPad 

Spin 3 phase Brushless DC and 

Brushless AC Motors 

Evaluate Hercules MCU  and 

TPS65381 Combination for Safety-

critical Applications 

Initial Software Development and 

Short-run Builds for System 

Prototypes 

Get Started on Development with 

Hercules MCU Platform 

USB Stick 

Low-cost Option to Evaluate 

Hercules MCU Platform 

Lowest cost Option to Evaluate 

Hercules MCU Platform 

HDK controlCARD 

RM48, RM46 RM48 

 RM48, RM46 RM48, RM46, RM42 

RM48 RM42 

Starting at $499 $499 

$79 $19.99 

$199 Starting at $99 
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TMS570LS31, LS12 TMS570LS31 

 TMS570LS31, 

LS12  
LS31, LS12, LS04  

TMS570LS31 TMS570LS04 

http://www.ti.com/tool/DRV8301-RM48-KIT
http://www.ti.com/tool/DRV8301-RM46-KIT
http://www.ti.com/tool/safeti-hsk-rm48?DCMP=herc-hitex&HQS=herc-hitex-pr-lp
http://www.ti.com/tool/tmdxrm48cncd
http://www.ti.com/tool/tmdxrm46cncd
http://www.ti.com/tool/tmdxrm48HDK
http://www.ti.com/tool/tmdxrm46HDK
http://www.ti.com/tool/tmdxrm42HDK
http://www.ti.com/tool/tmdxrm48USB
http://www.ti.com/tool/launchxl-rm42
http://www.ti.com/tool/DRV8301-LS31-KIT
http://www.ti.com/tool/DRV8301-LS12-KIT
http://www.ti.com/tool/SAFETI-HSK-570LS31
http://www.ti.com/tool/tmdx570ls31CNCD
http://www.ti.com/tool/tmdx570ls12CNCD
http://www.ti.com/tool/tmdx570ls31HDK
http://www.ti.com/tool/tmdx570ls31HDK
http://www.ti.com/tool/tmdx570ls12HDK
http://www.ti.com/tool/tmdx570ls04HDK
http://www.ti.com/tool/tmdx570ls31USB
http://www.ti.com/tool/launchxl-tms57004


         
 TMDXRM48HDK – RM48 Development Kit 

      TMDXRM46HDK – RM46 Development Kit 

      TMDXRM42HDK – RM42 Development Kit 

 TMDX570LS31HDK – TMS570 Development Kit 

 TMDX470MF066HDK – TMS470M Development Kit 
 

 

 
 

 
 

Hercules
TM

 Development Kits 

Software Included in Each Kit: 
• CCStudio IDE: C/C++ Compiler/Linker/Debugger 

• HALCoGen Peripheral Driver Generation Tool 

• CCS and nowFlash Flash Programming Tools 

• HET IDE: Simulator & Assembler 

• GUI Demo with Project/Code Examples 

 
 

 D
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TMDXRM48USB – RM48 USB Stick Kit 

TMDX570LS31USB – TMS570 USB Stick Kit 

TMDX470MF066USB – TMS470M USB Stick Kit 

•  USB Powered 

•  On Board USB XDS100v2 JTAG Debug  

•  On Board SCI to PC Serial Communication 

•  Access to Select Signal Pin Test Points 

•  LEDs, Temp Sensor & Light Sensor 

•  Accelerometer  

• CAN transceiver 
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$199 

• On Board USB XDS100v2 JTAG Debug  

• External high speed emulation via JTAG 

• CAN Tranceivers 

• LEDs, Temp Sensor & Light Sensor 

• TRACE pads for ETM/RTP/DMM (TMS570 & RM48) 

• RJ45 10/100 ENET (TMS570 & RM48 & RM46) 

• USB-A Host Interface (RM48 & RM46) 

• USB-B Device Interface (RM48 & RM46) 

$79 



Hercules™ LaunchPad 
        

LaunchPad Demos 

        

Kit Overview 
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• USB powered 

• On board USB XDS100v2 JTAG debug  

• On board SCI to PC serial communication 

• GIO & NHET LEDs 

• Ambient Light sensor 

• 40 pin BoosterPack XL Header 

• Footprint for an Expansion header (not 

populated) to bring out all MCU Pins 

• USB Cable 

• Quick Start Guide 

 
 

        

• LAUNCHXL-RM42 

• LAUNCHXL-TMS57004 

Hercules™ Safety MCU 

$19.99 

On Board JTAG (XDS100v2) 

BoosterPack  XL Interface 

GIO Push Button 

Ambient Light Sensor 



Hercules
TM

 Motor Control Development Kits 
        

• DRV8301-RM48-KIT 

• DRV8301-RM46-KIT 

• DRV8301-TMS570LS31-KIT 

• DRV8301-TMS570LS21-KIT 

 
 

 

        

Demo Software 

        

Software Included In the Kit 
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Hercules Safety MCU 

ControlCard 

Starting at 

$499 

DRV 8301 60V, 60A EVM with 
self protection and 

programmable gain amplifiers 

Teknic 7 Amp, 6000 RPM Motor 
with encoder and hall sensors 

• InstaSPIN-BLDC MotorWare™ Project 

• Sensored FOC with redundant SMO 

  MotorWare™ Project 

• Demonstration Examples 

• Code Composer Studio IDE 

• ARM Cortex-R4 CMSIS DSP Library 

• HALCoGen Driver Generation Tool 

• High End Timer  IDE 



SafeTI™ Hitex Safety Kit 
        

Hitex Safety Kit Software 

        

Kit Overview 
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• Cost effective entry into functional safety 

related to ISO26262 and IEC61508 

• Evaluation board supporting all safety 

features according to the safety manual 

• Error injection and reaction monitoring by 

second µC connected to GUI 

• Full source code available for modification 

of the application or including the library in 

your own application 

• Evaluation version of compiler and 

debugger included 

• Evaluation version of SafeRTOS included 

• User friendly documentation  

• 
• 

On Board Display 

Hercules™ Safety MCU 

TPS65381 Power Supply & 
Safety Monitor  

ControlCard Interface 

$499 

http://www.hitex.com/safeti  

        

• SAFETI-HSK-RM48 

• SAFETI-HSK-570LS31 

http://www.hitex.com/index.php?id=safety-safetihsk


76 

Hercules™ LaunchPad 

• Main Features 

– USB Powered 

– On Board USB XDS100v2 JTAG Debug  

– On Board SCI to PC Serial Communication 

– BoosterPack XL Interface 

– Access to Select Signal Pin Test Points 

– GIO Push Button 

– 1 White GIO LED 

– 1 White NHET LED 

– 1 Red nERROR LED 

– Ambient Light Sensor 

– 100p QFP Packaged MPU 

 

 

• $19.99 USD 

– TMS570 Orderable Part #  

• LAUNCHXL-TMS57004 

– RM42 Orderable Part #  

• LAUNCHXL-RM42 

 

100p Hercules 

QFP MCU  Light 
Sensor 

PORRST 
Button  

RST 
Button  

USB XDS100v2 JTAG  
SCI to USB  

JTAG LED 
SCI TX LED  
SCI RX LED 

Peripheral 
Pin Access 

BoosterPack  
XL Interface 

GIO Push 
Button 

$19.99 

NHET LED 

Power LEDs 

GIO LED 

BoosterPack 
 XL Interface 



77 

Microcontroller USB Stick Kit 

• Main Features 

– USB Powered 

– On Board USB XDS100v2 JTAG Debug  

– On Board SCI to PC Serial Communication 

– Access to Select Signal Pin Test Points 

– 6 White NHET LEDs 

– 2 RGB Tri Color NHET LEDs 

– Temp Sensor, Light Sensor and Accelerometer  

– CAN Communication transceiver 

– 337p BGA Packaged MCU 

 

 

• $79 USD 

– TMS570 Orderable Part # TMDX570LS31USB 

– RM48 Orderable Part # TMDXRM48USB 

– Code Composer Studio IDE included 

 

337p Hercules 

BGA MCU  

Temp  
Sensor 

Light 
Sensor 

PORRST 
Button  

RST 
Button  

USB XDS100v2 JTAG  
SCI to USB  

Power LED 
Error LED  

JTAG LED 
SCI TX LED  
SCI RX LED 

Peripheral Pin 
Access 

Peripheral Pin 
Access 

Tri-Color LED 
NHET1 [20, 05, 02] 

Tri-Color LED 
NHET1 [16, 27, 04] 

White LEDs 
NHET1 [25, 18, 29] 

White LEDs 
NHET1 [17, 31, 0] 

$79 

CAN Interface 
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Hercules™ Development Kit (HDK) 

• Main Features 

– On Board USB XDS100v2 JTAG Debug 

– External High Speed JTAG Connector  

– On Board SCI to PC Serial Communication 

– Access Signal Pin Test Points 

– Board Expansion Connectors 

– 6 White NHET LEDs 

– 2 RGB Tri Color NHET LEDs 

– Temp Sensor and Light Sensor 

– Micro SD Card Slot (SPI mode) 

– RJ45 10/100 Ethernet Interface 

– USB-B Device Interface (RM48 & RM46 Only) 

– USB-A Host Interface (RM48 & RM46 Only) 

– 2 CAN Communication Transceivers 

– 337p BGA Packaged MCU 

 

• $199 USD 
– TMS570LS31 Orderable Part # TMDX570LS31HDK 

– TMS570LS12 Orderable Part # TMDX570LS12HDK 

– RM48 Orderable Part # TMDXRM48HDK 

– RM46 Orderable Part # TMDXRM46HDK 

 
GIO Push Button 

Temp  
Sensor 

Options 
Switch 

CAN1 CAN2 Light 
Sensor 

             337p (BGA) 
Hercules  MCU  

USB mini-B: XDS100v2 JTAG  
SCI to USB  +5 - 12V  

DC Power Input  Micro SD Card Slot  RJ-45 

$199 

PORRST Button  

RST Button  

20 pin 
JTAG 

USB – B 
Device  
RM48 Only 

USB – A 
Host  
RM48 Only 



Printed Circuit Board Design 

Considerations 

79 
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MCU Package Selection – 100p (PZ) QFP  

• Package Size = 14x14 mm 

• 16 x16 mm including leads 

• 25 pins on each side 

• 0.5 mm pin pitch 

Typical Package Information: 
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MCU Package Selection – 144p (PGE) QFP  

Typical Package Information: 

• Package Size = 20 x 20 mm 

• 22 x 22 mm including leads 

• 36 pins on each side 

• 0.5 mm pin pitch 
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MCU Package Selection – 337p (ZWT) BGA  

Typical Package Information: 

• Package Size = 16 x 16 mm 

• 337 ball grid array 

• 0.8 mm ball pitch 
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MCU Crystal Selection – TMS570 & RM48 

Typical Crystal Connections: 

• OSCIN & OSCOUT pins 

• BGA Packages: Kelvin GND 

• Frequency Range: 5 to 25MHz 

5 MHz to 20MHz 

TI strongly encourages each customer to 

submit samples of the device to the 

resonator/crystal vendors for validation. The 

vendors are equipped to determine what load 

capacitors will best tune their 

resonator/crystal to the microcontroller 

device for optimum start-up and operation 

over temperature/voltage extremes. 
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External JTAG Headers 

60 Pin MIPI 

20 Pin CTI 

14 Pin TI 

20 Pin ARM 



• Excellent balance of performance and cost 

• USB interface (Ethernet version available) 

• 20pin TI, 14pin TI, 20pin ARM and 10pin ARM 
connectors 

• $295 

 

• Entry level JTAG emulator 

• USB interface 

• 3 models based on JTAG headers (14pin TI, 20pin TI, 
20/10pin ARM) 

• Free CCS XDS100v2 license available 

• $79 

 

XDS100v2 

External XDS JTAG Emulators 

XDS200 

• High performance JTAG emulator 

• USB or USB + Ethernet interfaces 

• Includes multiple JTAG adapters (14pin TI, 20pin TI, 
20pin ARM, 60pin MIPI, some include 60pin TI) 

• System Trace 

• $995 - $1495 

• Trace Receiver & XDS560v2 JTAG emulator 

• USB + Ethernet interfaces 

• MIPI60 and 60pin TI adapters 

• DSP & ARM Trace to pins 

• System Trace 

• $3495 

XDS560v2 Pro Trace 
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Power Supply Requirements 

Power I/C 
Hercules MCU: 
TMS570LS31x/21x/12x/04x and RM48x/46x/42x 

3.3V 

3.3V 

- Reset logic 

- Supply voltage supervisor 

nPORRST 

master reset 

(SYSESR.PORRST=1) 

device reset 

DWWD, 

sw reset, 

osc fault 

 system reset (bi-directional). 

If not connected, an external 

PU is recommend 

nRST 

VCCP 

VCCIO 

VSSAD GND 

3.3V  

ADREFHI 

3.3V 

VCC 

VSS 

VCCAD 

ADREFLO 

1.2V 

1.2V 

3.3V 

VIN 

VCCPLL 
1.2V 
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Power I/C 

3.3V 

5.0V 

nPORRST 

master reset 

(SYSESR.PORRST=1) 

device reset 

DWWD, 

sw reset, 

osc fault 

 system reset (bi-directional). 

If not connected, an external 

PU is recommend 

nRST 

VCCP 

VCCIO 

VSSAD GND 

3.3V  

VCC 

VSS 

ADREFLO 

1.2V 

VIN 

VCCPLL 
1.2V 

3.3V 

ADREFHI 

5.0V 

VCCAD 5.0V 

1.2V 

- Reset logic 

- Supply voltage supervisor 
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Power Supply Requirements 
Hercules MCU: 
TMS570LS31x/21x/12x/11x & RM48x/46x 



Hercules & TPS65381 Safety Companion IC 

TPS65381 
Hercules MCU: 
TMS570LS31x/21x/12x/11x & RM48x/46x 

5.0V 

3.3V 

nPORRST 

master reset 

(SYSESR.PORRST=1) 

SPICLK 

VCCP 

VCCIO 

VSSAD 

GND 

5.0V  

ADREFHI 

3.3V 

VCC 

VSS 

VCCAD 

ADREFLO 

1.2V 

1.2V 

3.3V 

VIN 

VCCPLL 
1.2V 
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5.0V 

CAN 

MCU 

Error Monitor 

Reset Logic 

nERROR 

SIMO SPI 

SOMI 

CS 

LBIST 

ABIST 

OSC MON 

Over Temp 

 MON 

Watchdog 

For more information about the TPS65381 go to : http://www.ti.com/product/tps65381-q1  

Package: 32-Pin HTSSOP PowerPAD™ 

(5.8V – 36V) 

Note: Some Hercules MCU ADCs are only 3.3V capable 

http://www.ti.com/product/tps65381-q1
http://www.ti.com/product/tps65381-q1
http://www.ti.com/product/tps65381-q1
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ADC Decoupling Capacitors 

TMS570LSx or RM4x MCU 

VSSAD 

VCCAD 

ADREFLO 

ADREFHI 

100nF 
Via to Ground Plane 

To 3.3V Power Supply 

100nF 
Via to Ground Plane 

To 3.3V Power Supply 
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Exercise: Hercules Safety MCU Demos 
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Lab1: Hercules™ Safety MCU Demos 
•   To  launch the demo software go to: 

•             → Programs → Texas Instruments → Hercules → Hercules Safety  

       MCU Demos 



Hercules Cortex™-R4F Architecture Overview: 

Memory Map, Clocking, Exceptions 
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High Performance Cortex-R4F floating-point CPU  

 

 

 

Up to 220 MHz CPU 

Clock Speed  Single / double 

precision IEEE 754 

floating-point 

Superscalar, SIMD, 

8 stage pipeline delivers  

1.6 DMIPS/MHz 

Fast MULT, DIV, and 

SQRT enables model-

based control; simplifies 

algorithm 

implementation 

12 region memory 

protection 

Floating point and 

integer instructions 

operate in parallel 

• Over 350 DMIPS of performance 

• High performance floating point 

• ARM-based: broad industry adoption 

ARM ® v7R CortexTM  ISA  

fully backward Compatible 

to ARM7/9/11 

Supports ARM, Thumb 

and Thumb-2 instructions 

Lockstep CPUs:  

Single core programming 

model – second core 

checks the first.  

ARM® 

Cortex™-R4F 
Up to 220 MHz 
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Broad IDE/Compiler Support: 

CCS, KIEL, IAR, GHS, etc… Scalable ARM Based 

Solutions from TI: 

Stellaris®, Concerto™ 

Hercules™& Sitara™ 



Cortex-R4F Features 

• 32-bit ARM and 16/32-bit Thumb2 instruction set 

• Integer unit with integral Embedded ICE-RT logic 

• Dynamic branch prediction with a global history buffer and return stack 

• Floating Point Unit 

• Low interrupt latency 

• Non-maskable interrupt 

• Harvard level one memory system with: 

– Tightly-Coupled Memories (TCM) interfaces with support for error correction or 

parity checking memories 

– Memory Protection Unit (MPU) 

• Level two memory interface: 

– Single 64-bit master interface 

– 64-bit slave interface, TCM RAM blocks and cache RAM blocks. 

• Debug interface to a CoreSight® ETM-R4® or CoreSight DAP 
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Cortex-R4F Pipeline 

64 

bit 

Fetch 
1st 

Stage 

Fetch  
2nd 

Stage 

Instruction 
formatting 
/ Branch 

prediction 

Instruction 
decode 

Register 
read and 

Instruction 
issue 

AGU 
(Address 

Generation 
Unit) 

Data 
Cache 
access 

1st 
Stage 

Data 
Cache 
access 

2nd 
Stage 

Write 
Back 

Shift ALU 

MAC 
1st 

Stage 

MAC 
2nd 

Stage 

Branch 
1st 

Stage 

Branch 
2nd 

Stage 

Branch 
3rd  

Stage 

Data 
Formatting 

MAC 3rd 
Stage 

Prefetches if 

branches/returns 

predicted to be 

taken 

FP 
Register  

read 

FP  
1st 

Stage 

FP 
 2nd  

Stage 

Round 
& 

Write-
Back 

Floating Point  
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Data Types 

• The processor supports following data types 

– Double Word (64 bit) 

– Word (32 bit) 

– Half Word (16 bit) 

– Byte (8 bit) 

 

• Although the processor supports unaligned accesses, TI does not 

recommend using unaligned accesses for bus performance 

– Above data types should be aligned at their respective size boundary 

– Most unaligned accesses are converted into multiple aligned accesses 

 

• The TMS570 devices store their data in word invariant big endian 
format (BE32) due to a modification in the memory interface 

 

• The RM4 devices store their data in little endian format (LE) 
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Memory Map 

• Flash starts at 0x00000000 and CPU 

RAM starts at 0x08000000 by default 

 

• Flash is mirrored outside of CPU TCM 

space for ECC diagnostics 

 

• Code execution is only allowed from 

Flash, RAM and external asynch memory 

by default 

 

• System and peripheral control registers’ 

space is defined to be “strongly-ordered” 

by default 

 

• CPU accesses to “Reserved” areas 

results in an Abort exception 

 

• Behavior on accesses to reserved 

locations within defined frames specified 

in datasheet 

 TMS570LS31x and RM48x 
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Clock Sources and Domains: TMS570LS31x/21x 

/1..64 X92..184 /1..8 /1..32 

Low Power 

Oscillator 

OSCIN 

/1..16 

/1..16 

0 

1 

4 

5 

6 

GCLK1 & GCLK2 (to CPUs) 

HCLK (to System Bus) 

VCLK (to Peripheral Bus) 

VCLK2 (to NHET/HTU) 

0 

1 

4 

5 

6 

VCLK 

VCLKA1 (to DCANx) VCLKA2 (to FlexRay/FTU) 

0 

1 

4 

5 

6 

VCLK 

/1,2,4, or 8 

RTI1CLK (to RTI & DWWD) 

Clock Source # 

3 
External Clock 1 

80 KHz 

10 MHz 

/1..32 /1..64 X92..184 /1..8 

7 
External Clock 2 

/1..16 VCLK3 (to EMIF/ENET) 

3 

7 

0 

1 

4 

5 

6 

VCLK 

3 

7 

7 

• Global Clock Module (GCM) manages all 

clock sources and domains 

• Flexible mapping of clock sources and 

domains 

• Unused clock sources and domains can be 

disabled to save power 

• Asynchronous clock domains used for 

communication interfaces with strict tolerance 

limits, e.g. CAN, EMAC, FlexRay 
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Clock Sources and Domains: RM48x/RM46x 

/1..64 X92..184 /1..8 /1..32 

Low Power 

Oscillator 

OSCIN 

/1..16 

/1..16 

0 

1 

4 

5 

6 

GCLK1 & GCLK2 (to CPUs) 

HCLK (to System Bus) 

VCLK (to Peripheral Bus) 

VCLK2 (to NHET/HTU) 

0 

1 

4 

5 

6 

VCLK 

VCLKA1 

(to DCANx) 

VCLKA3 (to USB) 

0 

1 

4 

5 

6 

VCLK 

/1,2,4, or 8 

RTI1CLK (to RTI & DWWD) 

Clock Source # 

3 
External Clock 1 

80 KHz 

10 MHz 

/1..32 /1..64 X92..184 /1..8 

7 
External Clock 2 

/1..16 VCLK3 (to EMIF/ENET) 

3 

7 

0 

1 

4 

5 

6 

VCLK 

3 

7 

7 

• Global Clock Module (GCM) manages all 

clock sources and domains 

• Flexible mapping of clock sources and 

domains 

• Unused clock sources and domains can be 

disabled to save power 

• Asynchronous clock domains used for 

communication interfaces with strict tolerance 

limits, e.g. CAN, EMAC, USB 
DIVR 

VCLKA3_DIVR 

 (to USB HOST) 



100 

Phase-Locked-Loops (PLL1 and PLL2) 

REFCLKDIV PLLDIV 

PLLMUL 

ODPLL PLLCTL2 

PLLCTL1 

PLL1CLK, fPLL1 OSCIN, fOSCIN   

              

 

NR 

 

/1..64 

NF 

 

/1..256 

 

ODPLL 

 

/1..8 

R 

 

/1..32 

 

 

PLL1 

 

 

REFCLKDIV PLLDIV 

PLLMUL 

ODPLL PLLCTL3 

PLLCTL3 

PLL2CLK, fPLL2 
 

              

 

NR2 

 

/1..64 

NF2 

 

/1..256 

 

ODPLL2 

 

/1..8 

R2 

 

/1..32 

 

 

PLL2 

 

 

• PLL1 is configured using PLLCTL1 and PLLCTL2 registers 

• PLL2 is configured using PLLCTL3 register 

• TRM describes procedure for configuring frequency modulation settings for PLL1 

• Frequency modulation not available for PLL2 
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Reset Sources 

• Power-on Reset 

– Asserted by external voltage supervisor, or by internal voltage monitor 

 

• Oscillator fail 

– Asserted by internal clock monitor when enabled by software 

 

• CPU Reset 

– Asserted by CPU self-test controller after LBIST operation completes 

 

• Software Reset 

– Asserted by software writing to the exception control register 

 

• External Reset 

– Asserted by external circuitry driving the warm reset (nRST) signal LOW 

 

• Debug Reset 

– Asserted by ICEPICK JTAG module 



Hercules™: Flash Tools 
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nowECC 

<return_value> nowECC [options] -i <input_file> [-o <output_file>] 

• Generates ECC data for program flash 

 

• Command-line executable 

 

• Return value = 0 indicates no error during operation 

– Separate error codes to differentiate each type of error 

 

• Input_file is only required parameter 

– Can be Extended Tektronix, Intel Hex, Motorola-S, COFF or ELF format 

 

• Output_file specifies the name of the output file to be generated 

– If no name is specified, ECC is appended to input file specified 



104 

Options for Flash Programming 

• On-board programming using Code Composer Studio v5.x/CCS UniFlash 

– Requires JTAG connection 

– Emulators Supported: 

• Blackhawk BHUSB560M 

• Spectrum Digital XDS200, XDS510USB, XDS560RUSB 

• Signum JTAGjet 

• Texas Instruments XDS100v2, XDS560 

 

• On-board programming via customer boot-loader code 

– Must use Texas Instruments released API routines 

– Multiple communication interfaces can be used 

– Necessary to validate program and erase routines 

 

• Off-board programming 

– Single-device or Concurrent programming 

– Supports high degree of automation 
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UniFlash Flash Programming Tool 

• PC-based software tool 

• Communicates with microcontroller via JTAG 

• Can be used to program and erase flash memory 

• Based on Eclipse – Supports Windows and Linux 

UniFlash WIKI 

http://processors.wiki.ti.com/index.php/Category:CCS_UniFlash
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Flash Application Programming Interface (API) 

• Distributed only as an object library file 

 

• Supports flash operations out of on-chip RAM 

 

• Supports operations at max specified device clock frequency 

 

• Library routines for 

– Blank check 

– Compaction 

– Erase 

– Program zeros 

– Program data 

– Calculate checksum 

– Verify 
 

• Routines also manage ECC 



Real-Time Interrupt Module (RTI) 
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RTI: Counter Block Diagram 

 

 

Up Counter 

 

 

RTICLK 

= 

Compare  

Up Counter 

 

Capture Up 

Counter 

 

 

Capture Free 

Running Counter 

 

 

External 

Control 

 

Capture Event Source 1 

Capture Event Source 2 

NTU0: Fray Macro Tick  

RTI Counter Features:  
• Two independent counter blocks for generating different time 

bases 

 

• Each block consists of 

– One 32-bit prescale counter 

– One 32-bit free-running counter 

– Two capture registers for capturing the prescale and 
free-running counters 

 

• External event can be used for incrementing free-running 
counter 0 

– Can be used for synchronizing with FlexRay bus 
communication cycle or external system clock input 

 

NTU1: Fray Start of Cyc 

NTU2: PLL2 

NTU3: EXTCLKIN1 

Free Running 

Counter To Compare Unit 

NOTE: Counter Block 1 does not contain external NTU inputs 
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RTI: Compare Block Diagram 

 

Update Compare 

 

= 

DMA Enable 

Counter Block 0 

RTI Compare Features:  
• Four compare interrupts and DMA requests 

– Each can use either of the two available free-running counters 

– Automatic update of compare values to minimize CPU intervention 

– Option to generate DMA request as well as the compare interrupt 

 

• Two counter-overflow interrupts 

– Generated when a free-running counter overflows and goes to zero 
 

 

Counter Block 1 

+ 

 

Compare 

 
DMA Req 

INT Req 

Interrupt Enable 



Vectored Interrupt Manager (VIM) 
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VIM: Block Diagram 

INT0 

INT94 

FIQ 

IRQ 

Phantom Interrupt 

Address ISR0 

Address ISR1 

Address ISR93 

Address ISR94 

VIM RAM 

REGISTERS 

VBUS P 

IRQVECTADDR [31:0] 

IRQACK } 
Vector Interrupt 

Interface 
from CPU 

P

e

r 

i

p

h

e

r
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l     
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s        

 

I

n

t

e

r

f

a

c

e 

C
H

A
N

N
E

L
 

M
A

P
P

I
N

G 

P
R

I
O

R
I

T
Y

 
D

E
C

O
D

E
R 



112 

VIM: Connection Block Diagram 

Peripherals – Interrupt Requests 

ESM ADC SCI SPI DCAN          NHET 

VIM 
 

CPU Interrupts Special Interrupts 

– Interrupt Enable 

– Interrupt Priority 

– Interrupt Mapping 

– Interrupt Generation 

RTI GCM CPU   VIC PORT 

       VBUSP 



113 

VIM: Main Features 

• VIM Hardware 
– Dedicated Vector Interrupt interface to ARM CPU 

– Hardware relocation of the IRQ vector address 

– Hardware assistance for prioritizing and controlling interrupt sources 

 
• VIM Functions 

– 96 interrupt requests  

– Map interrupt request to interrupt channel via programming. 

– Provides programmable priority through interrupt request mapping 

– Prioritizes the interrupt channels to the CPU 

– Provides the CPU with the address of the interrupt service routine (ISR) 

 
• VIM Modes 

– Legacy ARM7 Mode (FIQ/IRQ) 

– Vectored interrupt (FIQ/IRQ) 

– Hardware vectored interrupt (IRQ only) 



Direct Memory Access (DMA) 
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DMA: Main Features 

• 32 channels with individual 
enable 

 

• 64 DMA requests 

– Software and hardware 
DMA requests (event 
synchronization) 

 

• Supports 8, 16, 32 or 64 bit 
transactions 

 

• Multiple addressing modes for 
source/destination 

– fixed, incrementing, 
indexed 

 

• Auto Initiation 

• Channel chaining capability 

 

• 1 FIFO (First In First Out) 

 

• One AHB master port (64 bit 
wide) to interface with the bus 
matrix 

 

• One slave port to interface with 
VBUS for register interface 

 

• Memory Protection for the 
address range DMA can access 

Note: Not all Hercules MCUs are available with a DMA 
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DMA: How to Start a Transfer? 

• Software requests 

– By setting bit x in SWCHENAS [31:0] register transfer (channel x) will 
be triggered. 

 

 

• Hardware requests 

– An active DMA request signal will trigger a DMA transaction. 

– Up to 64 DMAREQ lines can be handled. 

– Since DMA controller is clocked by HCLK, the duration of all DMA 
requests signals must be at least HCLK long. 

 

 

• Triggered by other control packet 

– When a control packet finishes the programmed number of transfers 
it can trigger another channel to initiate its transfers. 
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DMA: Channel Interrupts 

 

• Each channel can be configured to generate interrupts 
on several transfer conditions: 
 

– FTC (Frame Transfer Complete) interrupt 
 

– LFS (Last Frame Transfer Started) interrupt 
 

– HBC (First Half of Block Complete) interrupt 
 

– BTC (Block Transfer Complete) interrupt 
 

– BER (Bus Error) interrupt 



Memory Protection 

0xFFFFFFFF 

0xFFF78000 

0x08003FFF 

0x08000000 

0x00000000 

Region 3 

Region 3 

Region 1 

System + Peripherals 

No access restriction 

Access restriction apply 

Region 3 

Region 2 

Region 1 

Region 0 

System + Peripherals 

RAM 

No access restriction 

Access restriction apply 
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General-Purpose I/O (GPIO) 

119 



GIO Main Features 

• Two ports (GIOA/B), each with 8 bidirectional and bit-programmable I/O pins 

• External interrupt capability 

– Programmable interrupt detection on single or both edges 

– Programmable edge detection polarity 

– Programmable interrupt priority 

• Possible pin configurations: 

– Data direction 

– Data input/output 

– Data set/clear 

– Open drain 

– Pull-up/Pull-down 
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GIOA 

External 

Interrupt Block 

VIM 

GIOB 

V
B

U
S

P
 (

P
e
ri

p
h

e
ra

l 
B

u
s
) 

GIOA[7:0] / INT[7:0] 

GIOB[7:0] / INT[7:0] 



GIO Block Diagram 

External  

pin 

GIODSETx 

High priority 

Low priority 
Interrupt enable 

Interrupt disable 

Rising edge 

Falling edge 

To  
VIM 

To  
VIM 

P
e
rip
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e
ra
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s
 / V
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S
 

GIOPULDIS 

GIOPSL 

GIODIRx 

GIOINTDET 

GIODOUTx 

GIODINx 

OPEN  

DRAIN  

LOGIC 

GATES 

GIOPDRx 

GIODCLRx 

High-level-  

interrupt  

handling 

GIOENASET 

GIOENACLR 

Low-level- 

interrupt  

handling GIOLVLSET 

GIOLVLCLR 

GIOFLG GIOPOL 
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GIO Cell Configuration 
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GIO pin 

Input Buffer 

3-state Output Buffer 

Pull-down 

Pull-up 

GIODOUT[x] 

GIODIR[x] 

GIODIN[x] 

GIOPSL[x] 

GIOPULDIS[x] 

GIOPDR[x] 

Register Description 

GIOPSL Selects the pull type at pin (pull-up / pull-down) 

GIOPULDIS Disables the pull control capability at pin 

GIOPDR Controls the open drain configuration of the pin 

GIODOUT Controls what information is sent to external pin when configured as output 

GIODIN Receives information from external pin 

GIODIR Controls the direction of the pin (input / output) 



High-End Timer (N2HET) 
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• User-programmable Timing Co-Processor 

 

• Provides high level and complex timing 
functions with low CPU overhead 

 

• 128 word instruction RAM with Parity protection 

 

• Dedicated DMA functionality (HTU) to transfer 
data from NHET to Data Ram w/o CPU 

 

• Conditional program execution based on pin 
conditions and compares 

 

• 32 input/output (I/O) channels (pins) for 
complex or classical timing functions such as 
capture, compare, PWM, GPIO 

 

• Suppression filters eliminate undesired input 
frequencies 

 

• Multiple 25-bit virtual counters for timers, event 
counters, and angle counters 

 

• High Resolution I/Os and coarse resolutions 
implemented by sub loops for multiple 
resolution capability 

High End Timer (NHET) 

32 I/O Channels 

Host 

interface 

Address/Data Bus 

Timer 

RAM 

Execution 

Unit 

Input/ 

Output 

Unit 

Compare 

32 bit ALU 

    Register A, B, T 

Instruction Register 

Address Register 

Interrupt Control 

Operation Control 

Program RAM Control RAM Data RAM 

CPU wait control 

Shadow registers Prescaler 

Global & prescale control 

register 

I/O Control 

Register 
Synchronizers 

32 High Resolution Channels 
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NHET: Application Examples 

Pulse Width Modulation 

 

•  Single / multi channel PWMs 

 

•  PWM with synchronous / asynchronous duty 

   cycle update 

 

•  PWM with synchronous period update 

 

•  Phase shift PWM's using RADM64 instruction 

Other Features 

 

•  Frequency Modulated Output   

 

•  Pulse width count (using PWCNT) 

 

•  Time stamp (using WCAP)  

 

•  Event counter (using ECNT) 

 

•  Pulse accumulator example (using ECNT ) 

 

•  Multi-resolution scheme 

 

Frequency and Pulse Measurements 

 

•  Pulse width and period measurement (using PCNT) 

 

•  Period measurement using PCNT in HR mode, HRshare feature and 64 bit read access with “auto 

read/clear” bit set 
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NHET: Command Line Assembler 

• Invoking the NHET assembler (hetp.exe):        hetp [options] input file  

 

• Options: 

– -c32  produces an output file containing assembler directives for the TMS570 

 CodeGen Tools 

– -hc32  produces a C file and a header file. (used together with the -nx option) 

– -nx  specifies the x-th HET module on the device (used together with -hc32 

 option) 

– -l         (lowercase L) produces a listing file with the same name as the input file 

 with a .lst extension. 

– -x        produces a cross-reference table and appends it to the end of listing file.  

 

• Example: hetp -hc32 -n0 pwm.het 

• Input:  pwm.het   contains the assembly source of the HET program 

• Output:  pwm.c      provides a C array, which contains the HET 

    program opcode 

            pwm.h      provides a C structure, which allows a simple 

     access to the NHET fields from other C code 



High-End Timer Transfer Unit (HTU) 
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HTU: Block Diagram 

32 -  Data 

9 - Address 

8  - Requests 

8  - Requests 
High 

End  

Timer 

 (NHET) 

(Quiet) 

Transfer Unit (TU) 

Register Bank 
 

 

 

 

 

 

Local RAM 
8 Double Control  

Packets 
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HTU: Main Features 

• CPU and DMA independent 

 

• Master Port to access directly 
system memory 

 

• HTU master accesses protected by 
dedicated Memory protection Unit 

 

• One Slave port to interface with 
VBUS for register interface 

 

• Maximum of 8 double control 
packets supporting dual buffer 
configuration 

 

• Control packet information is stored 
in RAM protected by parity 

 

• Event synchronization (HET transfer 
requests) 

• Support 32 or 64 bits transaction 

 

• Addressing modes for HET address 
(8 byte or 16 byte) and system 
memory address (fixed, 32 bit or 
64bit) 
 

• Each type of interrupt can be routed 
to either two different host CPUs 

 

• One shot, circular and auto switch 
buffer transfer modes 

 

• Request lost detection 
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Exercise: PWM Generation using the NHET 
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Overview 
• In this exercise we will: 

– Create a new  HALCoGen Project 

– Configure HALCoGen to generate  

• A basic PWM with a period of 1 second and a duty cycle of 75%  

– Use the PWM to toggle the NHET[08] LED on the board 

– Generate and Import code into Code Composer Studio 

– Build and Deploy our code to the microcontroller 

 

• Required Hardware: 

– Windows Based PC (WinXP, Vista, 7) 

– TMS570 LaunchPad or RM4 LaunchPad  
 

 

• Required Software: 

– HALCoGen 

– Code Composer Studio  

 

http://focus.ti.com/docs/toolsw/folders/print/halcogen.html
http://processors.wiki.ti.com/index.php/Download_CCS
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HALCoGen GUI Overview 

Output/Status 

Menus and Icons 

Device 

Block 

Diagram  

Module Selection/Configuration  

Help 
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HALCoGen Help 

• HALCoGen’s embedded help window provides full documentation of 

each communication drivers, implemented functions, file dependencies 

and examples. 
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HALCoGen File Dependencies and Function Listing 

File 

Information 

Control 

File 

Dependency 

Diagram 

Function 

Listing 

File 

Explorer 



Set up a New HALCoGen Project 
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•   To  launch HALCoGen go to: 

•             → Programs → Texas Instruments → Hercules → HALCoGen 

 
•   Create a new project: 

• File → New → Project 

 

• For the TMS570 Kit:  
– Choose Family: TMS570LS04x 

– Device: TMS570LS0432PZ 

 

• For the RM4 Kit:  
– Choose Family: RM42x 

– Device: RM42L432PZ 

 

• Then define a name: ‘PWM’ 

• Location: “C:\myWorkspace” 

1 

4 

2 

3 



Driver Enable 
• In ‘Driver Enable’ tab enable the HET driver. 
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1 

2 

3 



NHET PWM Configuration 
• In ‘HET’  ‘PWM 0-7’ tab: 

• Configure PWM 0 to 75% Duty Cycle, with a Period 1000000.00uS on Pin 8 
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N2HET Output Configuration 

• In the ‘HET’  ‘Pin 8-15’ tab: 

• Enable the output on Pin 8 

 

• Generate Code: File → Generate Code  
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Setting up Code Composer Studio  

• Launch Code Composer Studio (CCS) 

– Start   → Programs → Texas Instruments → Code Composer Studio v5   

                                                        →  Code Composer Studio v5 

• When it launches, CCS will ask you to select a workspace, we will chose             

“C:\myWorkspace” 

 

 

 

 

 

• Once CCS loads, go to  

 File → New → CCS Project 
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Setting up our Project 
• Our project name needs to match the name of our HALCoGen Project:      

‘PWM’ 

• Make sure that your project 

 ‘Family’ is set to ARM 
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• Next, set the Variant  

      to “Cortex R” 

 • For the TMS570 kits:  
– Choose: TMS570LS0432 

 

• For the RM4 kits:  
– Choose : RM42L432 

 

• Then click ‘Finish’ 

 

1 

3 2 

• Then set the ‘Connection’ to the 

      Texas Instruments XDS100v2 
 

• Then select ‘Empty Project  

 

4 

6 

5 



• Next we need to add our ‘include’ directory to the project from the CCS “Project 

Explorer” 

 

 

 

Setting up our Project 
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1 

2 

• Right click on the 

‘PWM’ project in 

the Project 

Explorer  

 

 

• Then choose 

‘Properties’ 

 



Setting up our Project 
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1 

3 

2 

• Then in the 

‘Properties’ window 

expand the ‘Build -> 

ARM Compiler’ 

category and select 

‘Include Options’ 

 

• Then select the ‘+’ 

button to add the 

directory with our 

‘.h’ header  files 

 

• In the ‘Add directory 

path’ window, click 

the ‘Workspace…’ 

button 

 

• Finally, select the ‘include’ 

folder that HALCoGen 

created for us that 

contains all our ‘.h’ header 

files 

 

4 



• Expand the project and open the “sys_main.c” file from the ‘source’ folder in 

the CCS “Project Explorer”  

 

 

Enter Code into the CCS Project 

143 

2 

3 

1 
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Code Composer Studio 

• In the Code Composer Project and enter the following code: 

– Inside User Code 1, insert the code below. 

 

 

 

 

 

– Then in User Code 3, insert the code below. 

/* USER CODE BEGIN (1) */ 

#include "het.h" 

/* USER CODE END */ 

/* USER CODE BEGIN (3) */ 

hetInit(); 

while(1); 

/* USER CODE END */ 



• The code is now complete and we are ready to build our project. 

– Go to Project → Build All 

 

 

 

 

 

 

 

 

 

 

 
 

NOTE: It may take a 3 to 5 minutes to compile the RTS (Run Time Support Library) the first 

time a project is built. 

Compiling the Project 
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Programming the Flash 

• We are now ready to program the flash. 

– Go to Run → Debug 

– A new window should appear as it programs the flash memory. 

• This may take a few moments. 

146 



• Click the green arrow on the debug tab to run our program 

 

 

 
– Alternatively the program can be run without the debugger connected by pressing the PORRST 

button on the LaunchPad 

• Clicking the red square on the debug tab to terminate the debugger’s connection 

• Hitting the reset button on the board and observe the behavior of the NHET LED  

  

 

 

 

 

 

 

 

• Congratulations! You have completed the exercise. 

 

Testing our Program 
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Possible Errors 
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• RM42x kits: 

A build error may occur when using some versions of Code Composer Studio 

       before v5.5  

 

 

This error occurs because certain versions of CCS do not include the RTS (Run Time Support 

Library) for the little endian non floating point Cortex-R4 (rtsv7R4_T_le_eabi.lib) by default. 

 

 To resolve this issue: 
 

1) Open the “Properties” for the CCS project 
 

1) In the “General” Settings: 

• Set the “Device endianness:” to  “little” 

• Set the “Runtime support library:” to 

“<automatic>” 
 

2) Re-Build the CCS project 
 

 

NOTE: It may take 3 to 5 min to compile the 

RTS Library after this configuration change is 

made. 

 

 



Possible Errors 
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• TMS570 kits: 

A build error may occur when using some versions of CCS before v5.5  

 

 

This error occurs because certain versions of CCS set the floating point RTS (Run Time Support 

Library) for the big endian for non floating point Cortex-R4 MCUs by default. 

 

 To resolve this issue: 
 

1) Open the “Properties” for the CCS project 
 

1) In the “General” Settings: 

• Set the “Runtime support library:” to 

“<rtsv7R4_T_be_eabi.lib>” 

 
NOTE: It may take 3 to 5 min to compile the 

RTS Library after this configuration change is 

made. 

 

 



Multi-Buffered Serial Peripheral Interface 

(MibSPI) 

150 



SPI – Block Diagram & Features 
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VBUS Write 

VBUS Read 

TX SHIFT REGISTER 

  TX BUF   

  RX BUF   

nCS[7:0] 

nENA 

CLK 

SIMO 

 

 

Mode 

Generation 

Logic 

 

 

  SPI BUF   

RX SHIFT REGISTER 

SPIDAT0 SPIDAT1 

CHARLEN 

16 

16 

16 

16 

SOMI 

PRESCALE 

PHASE 

POLARITY 

• 16-bit Shift Registers 

• Double-buffered TX and RX 

• Master or Slave Mode 

• Up to 4 SIMO / SOMI in parallel 

• Selectable MSbit or LSbit first transfer 

• Unused pins available as GP I/O 

• CLK frequency VCLK/2 to VCLK/256 

• 2- to 16-bit character length 

• Selectable CLK phase and polarity 

• Interrupt / DMA requests when 

• TX buffer empty 

• RX buffer full 



RX DATA STATUS 
RX DATA STATUS 

RX DATA STATUS 

TX DATA CTRL 
TX DATA CTRL 

TX DATA CTRL 

MibSPI – Block Diagram, Features 
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TX SHIFT REGISTER 

nCS[7:0] 

nENA 

CLK 

SIMO 

 

 

Mode 

Generation 

Logic 

 

 

RX SHIFT REGISTER 

TX DATA CTRL 

CHARLEN 

16 

16 

SOMI 

PRESCALE 

PHASE 

POLARITY 

• 16-bit Shift Registers 

• Up to 128 buffers for TX and RX 

• Up to 8 transfer groups 

• 15 sources to trigger transfers 

• Memory protected by parity 

• Master or Slave Mode 

• Up to 4 SIMO / SOMI in parallel 

• Selectable MSbit or LSbit first transfer 

• Unused pins available as GP I/O 

• CLK frequency VCLK/2 to VCLK/256 

• 2- to 16-bit character length 

• Selectable CLK phase and polarity 

• Programmable interrupt and DMA 

request generation conditions 

• Up to 16 DMA requests 

RX DATA STATUS 

VBUS Write 

VBUS Read 



SPI / MibSPI Safety Features 

• Parity Error detection for all reads from MibSPI RAM 

• Continuous monitoring of transmitted data in master and slave modes 

• Detection of slave de-synchronization (master mode only) 

• Timeout for a non-responsive slave (master mode only) 

• Receiver overrun interrupt condition to prevent data loss 

• Detection of a mismatch in data length 

13 
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MASTER SLAVE 

(MASTER = 1 ; CLKMOD = 1) (MASTER = 0 ; CLKMOD = 0) 

SPIDAT1 SPIDAT0 

MSB LSB MSB LSB 

WRITE TO SPIDAT1 

SOMI 

SIMO 

SOMI 

SIMO 

SPICLK SPICLK 

nSCS[7:0] nSCS 

nENABLE nENABLE 

WRITE TO SPIDAT0 

SPICLK 

SIMO 

SOMI 

WRITE TO SPIDAT0 (SLAVE) 

nENABLE 

WRITE TO SPIDAT1 (MASTER) 

nSCS 

Transfer Mode – Five Pin Option 

Hardware Handshake 

12 
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Clock Options 

CLOCK POLARITY = 0, CLOCK PHASE = 0 

WRITE SPIDAT 

SPICLK 

SPISIMO 

SPISOMI 

SAMPLE IN 

RECEPTION 

MSB D6 D5 D4 D3 D2 D1 

D0 

LSB 

D6 D5 D4 D3 D2 D1 D7 

CLOCK PHASE = 0    (SPICLK WITHOUT DELAY) 

 

 - DATA IS OUTPUT ON THE RISING EDGE OF SPICLK 

 - INPUT DATA IS LATCHED ON THE FALLING EDGE OF SPICLK 

 - A WRITE TO THE SPIDAT REGISTER STARTS SPICLK 

1 2 3 4 5 6 7 8 
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SPI / MibSPI Parallel Mode 

• In order to achieve higher data flow, the parallel mode of the SPI / MibSPI enables 
the module to send data over more than one data line (Parallel 2, or 4). 

 

• Figure of Parallel Mode with Shift register MSB first: 

• Notes:  

– When parallel mode is used, the data length must be set as 16 bits 

– If parity is enabled one additional SPICLK will trigger the parity bit transfer 
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SPI / MibSPI 
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Timing Setup – Delay Register (SPIDELAY) 

tC2TDELAY = (C2TDELAY / VCLK) + 2 

tC2EDELAY = (C2EDELAY / 

SPICLK) 

tT2CDELAY = (T2CDELAY / VCLK) + 1 

SCSx 

ENAx 

SPICLK 

VBUSPCLK 

SOMI 

tT2EDELAY = (T2EDELAY / 

SPICLK) 

 

CSHOLD = 1 (held active/ dotted line)  

CSHOLD = 0 (set CS high after transmission) 

WDELAY 

DATA 



Controller Area Network 

(DCAN) 
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DCAN Features Overview  

• Full CAN according to protocol version 2.0 part A, B 

• Standard and Extended Identifiers 

• Programmable Bit Timing, Bit rates up to 1 MBit/s 

• Up to 128 Message Objects (MO) 

• Identifier Masks for each Message Object 

• Programmable FIFO mode for Message Objects 

• Dual clock feature 

• Possible automatic retransmission of a frame in case of lost arbitration or error 

• Bus diagnostic: Bus off, Bus error passive, Bus error warning, Bus stuck dominant 

• Frame error report: CRC, Stuff, Form, Bit and Acknowledgement errors 

• Programmable loop-back modes for self-test operation 

• Suspend modes for debug support 

• Parity check mechanism for all RAM modules 
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DCAN Block Diagram & Features 

 DCAN 

Message 
RAM 
Interface 

Module Interface 

Me ssage  Ha ndler 

Registers & MO access 

CTRL VBUSP 

CAN_TX 

Message 
RAM 

(8, 16 or 32 bit) 
INT requests DMA requests 

VCLKA 

CAN_CLK 

CAN_RX VCLK 

Test Modes 

only 

CAN Core 
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•  Full CAN (protocol version 2.0 A, B) 

•  CAN Core 

– Handles all CAN protocol functions 

•  Message Handler 

– Controls data transfer between CAN  
core, message interface registers 
and RAM 

– Handles acceptance filtering and 
interrupt/DMA requests 

•  Message RAM 

– Up to 64 Message Objects 

•  Registers & Message Object access (IFx) 

– Status and configuration registers for 
module setup and indirect Message 
Object access through interface 
registers (IFx) 

•  Module Interface 

– 2-bit interface to VBUS peripheral 
clock domain 



CAN Bus 

• Two wire differential bus (usually twisted pair) 

• Max. bus length depend on transmission rate 

– 40 meters @ 1 Mbps 

CAN 

NODE B 

CAN 

NODE A 
CAN 

NODE C 

CAN_H 

CAN_L 

120120
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CAN Node 
Wired-AND Bus Connection 

RX TX 

CAN Controller 
(Hercules MCU) 

CAN_L 

CAN_H 

120120

CAN Transceiver 
(EX: TI SN65HVD23x) 
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http://www.ti.com/product/sn65hvd232  

http://www.ti.com/product/sn65hvd232
http://www.ti.com/product/sn65hvd232


CAN Message Format 

• Data is transmitted and received using Message Frames 

• 8 byte data payload per message 

• Standard and Extended identifier formats 

  Standard Frame: 11-bit Identifier (CAN v2.0A) 

 Extended Frame: 29-bit Identifier (CAN v2.0B) 

11-bit 

Identifier 

R 

T 

R 

S 

O 

F 

I 

D 

E 

r0 DLC 0…8 Bytes Data CRC ACK 

E 

O 

F 

Arbitration 

Field 

Control 
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18-bit  
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Arbitration Field Data Field 
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FlexRay / Transfer Unit 
(Available on select TMS570 MCUs Only) 
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FlexRay Feature Overview 

• Open Bus System 

 

• Support of redundant transmission channels 

 

• Data rate of 20 Mbit/sec (10Mbit/sec per channel) 
 

• Support of a fault tolerant synchronized global time base  

 

• Static and dynamic data transmission (scalable) 

– Deterministic data transmission 

– Arbitration free transmission 
 

• Fault tolerant and time triggered services implemented in hardware 

 

• Support of optical and electrical physical layers 
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FlexRay Block Diagram  
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FlexRay Communication Structure 
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FlexRay Message Frame Format 
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Frame ID 
Payload 

Length 
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Header 
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Cycle 
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Data 0 Data 1 Data n CRC CRC CRC 

0 … 254 bytes 24 bits 

Payload Segment Header Segment Trailer Segment 

FlexRay Frame 5 + (0 … 254) + 3 Bytes 



Flexible Time Division Multiple Access Fixed Time Division Multiple Access 

FlexRay Communication Cycle 
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FTU Data Transfer Scheme 
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FlexRay Transfer Unit Key Features 

 

 

 

 

• Data Transfer without CPU interaction 

– From FlexRay Message RAM to Data RAM (Read)  

– From Data RAM to FlexRay Message RAM (Write)  

 

• Transfer Types   

– data and header section 

– header section only 

– data section only 

 

• Transfer Configuration RAM (with Parity) 

– Configures the transfer sequence 

– Parity protection 

 

• Triggers to Start a Transfer 

– CPU driven (single transfer sequence) 

– Event driven (single or continuous transfer sequence) 
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FlexRay Transfer Unit Key Features… 

• Different Transfer Conditions 

– If the status flags (header section) of the respective 
message buffer has been updated  

– If the data section of the respective message buffer has 
been updated 

– Always  

 

• Maskable interrupt generation when Message Buffer transfer 
is finished 

 

• Memory Protection Unit 

– One memory section (start- and end address) can be 
defined 

– No memory section is setup after reset  
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Ethernet Media Access Controller (EMAC) 
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EMAC Sub System: Features 

• EMAC Module 

– Synchronous 10/100 Mbps operation 

– Standard MII or RMII to external physical layer device (PHY) 

– Master port for transfers to/from internal and external RAM 

– Transmit and Receive Quality-of-Service (QoS) support 
 

• EMAC Control Module 

– Ether-Stats and 802.3-Stats statistics gathering 

– 8 kB local EMAC descriptor memory (CPPI RAM) 

• Enough to transfer up to 512 Ethernet packets without CPU intervention 

– Programmable interrupt logic 

• Allows restriction of back-to-back interrupt generation 
 

• MDIO Module 

– Implements the 802.3 serial management interface 

– Can control up to 32 Ethernet PHYs using a shared 2-wire bus 

– Used to configure each PHY connected to the EMAC 



EMAC Block Diagram 

175 

 EMAC Sub System 
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MII Connections 
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http://www.ti.com/product/dp83640  

http://www.ti.com/product/dp83640
http://www.ti.com/product/dp83640


RMII Connections 
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Universal Serial Bus (USB) 
 (Available on select RM MCUs Only) 
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USB Controller: Features 

• One full-speed USB device port 

– Compliant to USB Specification Rev 2.0 and Rev 1.1 

– Interfaces host processor and the external USB transceiver (PHY) 

 

• Two USB host ports 

– Compliant to USB Specification Rev 2.0 

– Based on Open Host Controller Interface (OHCI), Release 1.0a 

– Support for Overcurrent protection and automatic power switching 

 

• Second host port terminals are shared with device port terminals 

– Can use 2 USB host ports, or 1 USB host port and 1 USB device port 



  

USB Host Port Connections 
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http://www.ti.com/product/tusb1105  

http://www.ti.com/product/tusb1105
http://www.ti.com/product/tusb1105


USB Device Port Connections 
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http://www.ti.com/product/tusb1105  
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Serial Communication Interface (SCI/UART/LIN) 
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• Programmable Frame Format 

  1 Start Bit 

  1 to 8 Data Bits 

  0 or 1 Address Bit 

  0 or 1 Parity Bit 

  1 or 2 Stop Bits 

• Asynchronous Communications Format 

• 2 Multiprocessor Modes with Wake-up Capability  

 Idle-Line Mode; Address-Bit Mode 

• Programmable Baud Rate 

– More than 16 700 000 different Baud Rates 

– Max 3.125Mbps with 100MHz VCLK 

•  Error Detection 

– Parity, Overrun and Framing Error 

– Break Detect 

•  Noise Protection Capability 

•  Double-buffered Receive and Transmit Function 

SCI Features 
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SCI Block Diagram 

TXRDY 
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RX INT ENA 

WAKE UP 
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P/O/F ERROR 
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Shift Register 

 INT ENA 

 INT ENA 
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START 0 

(LSB) 

1 2 3 4 5 6 7 

(MSB) 

PARITY STOP 

IDLE-LINE mode 

START 0 

(LSB) 

1 2 3 4 5 6 7 

(MSB) 

PARITY STOP ADDR 

address bit 

ADDRESS-BIT mode 

SCI Frame Format 
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Typical LIN Applications (TMS570) 

Rear Door  Lock, 

window 
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Lock, window 

Fan 
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Wipers 
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Steering 

wheel 

Rear Door  Lock, 

window 
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• Compatible with LIN 1.3 or 2.0 

• LIN 2.0 Master Compliant  

• HW LIN protocol handler 

– Multi-buffered receive and  

transmit units 

– Automatic checksum 

generation 

and validation 

– ID masks for message 

filtering 

– DMA capability 

• Synch break detection 

• Slave automatic synchronization 

• Optional baud rate update 

• Synchronization validation 

• Automatic bit monitoring 

• Automatic error detection 

LIN 

SCI 

 8  

 8  TRANSMIT  
BUFFERS 

INTERFACE 

DMA  

CONTROL 

READ DATA BUS 

LINRX 

LINTX 

ADDRESS BUS 

MASK  

FILTERS 

SYNCHRONIZER 

COUNTER 

TIMEOUT  
CONTROL 

COMPARE 

FSM 

TXRX ERROR  

DETECTOR  
(TED) 

CHECKSUM  
CALCULATOR 

BIT MONITOR 

ID PARITY  
CHECKER 

LIN Key Features 

RECEIVE  
BUFFERS 

WRITE DATA BUS 
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External Memory Interface (EMIF) / 

Parameter Overlay Module (POM) 
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EMIF: Block Diagram 

Switch Central Resource 
(SCR) 

 

EMIF_nCS[0] 

EMIFnOE 

EMIF_nWE 

EMIF_BA[1:0] 

EMIF_nDQM[1:0] 
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EMIF_ADDR[21:0] 

EMIF 
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Interface 
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and 
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EMIF: Main Features 

• Asynchronous Memory Support 

– Interfaces to SRAM memories as well as NOR Flash memories 

– 22 address lines, 3 chip selects of up to 16MB each 

– 16-bit data bus width 

– Programmable cycle timings 

– Select strobe mode option 

– Extended wait mode with programmable timeout period 

– Data bus parking 

• Synchronous DRAM Memory Support 

– One, Two and Four Bank SDRAM devices 

– 22 address lines, 1 chip select 

– Devices with Eight, Nine, Ten, and Eleven Column Addresses 

– CAS latency of two or three clock cycles 

– 16-bit data bus width 

– 3.3V LVCMOS Interface 

– Support for SDRAM Self-Refresh and Powerdown modes 
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Data 

 Wrapper 
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SCR 

Other Master 
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• Redirects program memory accesses to 
internal/external memory interface (overlay) 

• Provides up to 32 programmable memory 
regions to replace non-volatile memory 

– Programmable region start address 

– Programmable region size (64 Bytes up to 256kBytes 

in power of 2 steps) 

• Up to 4 MByte of external overlay memory 
– 22 bit start address size 

• Overlay memory is memory mapped 
– Writable by any master (e.g. CPU, DMA, DMM, etc.) 

Parameter Overlay Module 

Program  

Memory 



POM - Overlay Region Example 

0x00024400 

Program Memory 
Overlay Memory 

0x00001000 

64 Bytes 

1K Bytes 

0x00000000 

0x00000400 
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1K Bytes 

64 Bytes 



Multi-Buffered Analog to Digital Converter  

(MibADC) 
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MibADC Block Diagram 
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MibADC ADC Implementation 
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• Available Dual12-bit ADC cores: 

– MibADC1 (AD1IN + ADSIN = 24 ch) 

 MibADC2 (ADSIN = 16 ch) 

– 16 analog channels shared between the 
2 cores for safety critical 
conversions/comparison  

– Internal ADC reference voltages can be 
used to check converter functionality 

– Self Test Mode enables application to 
detect opens/shorts on ADC inputs 

– ADC calibration logic can improve 
accuracy or be used to detect drift 
between multiple test results 

  offset error correction 
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Note: Not all Hercules MCUs are available with dual ADCs 



MibADC Operation Modes 
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• Normal active mode for converting the selected external input voltage 
Conversion 

Mode 

• Active mode that grounds the ADC sampling capacitor 

Sample 
Capacitor 
Discharge 

Mode 

• Special active mode for calibration using internal reference voltages 
Calibration 

Mode 

• Active mode for failure-detection using internal reference voltages Self-Test Mode 

• Inactive mode in which the ADC internal clock is stopped 
Power-Down 

Mode 



MibADC Conversion Groups 

Event group select 

(ADEVSEL) 

Event 

group 

FIFO 

12    value 

8    value 

read 

 

ADEVBUFFER 

ADG1SEL ADG2SEL 

Input Channel Select Registers 

Group 1 

FIFO 

 9    value  3    value 

Group 2 

FIFO 

read 

 

ADG1BUFFER 

read 

 

ADG2BUFFER 

31 0 31 0 31 0 

1 1 1 1 
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S/H 

VCCAD VSSAD 

Vin 

VREFHI VREFLO 

ADCLK Start EOC 

OUT 
   12 

ACQ11:0 

RESET 

MibADC Conversion Result 

12 bit ADC:  DIGITAL_RESULT = 4096 * (Vin – VREFLO) / (VREFHI - VREFLO) 

12bit 
Analog – Digital Converter 
(successive approximation) 
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MibADC Interrupts 
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• All channels that are assigned to a particular group are converted 
Group 

Conversion End 

• Number of conversion results exceed threshold register value  Group Memory 
Threshold 

• Number of ADC conversions exceed the number of buffers allocated for that 
conversion group 

Group Memory 
Overrun 

• Magnitude comparison of conversion result on up to three channels. 
Programmable compare between two channels’ conversion results or a 
channel’s conversion result with a threshold value 

Magnitude 
Threshold 

• On parity error the ADC module sends a parity error signal to the System module Parity Error 



Exercise:  
Using the MibADC to collect Ambient Light Sensor data 
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ADC Exercise Overview 

• In this exercise we will: 

– Acquire data from the ambient light sensor using the ADC module 

– Send the converted ADC value back through the SCI/UART module to the 

PC. 
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Set up a New HALCoGen Project 
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•   To  launch HALCoGen go to: 

•             → Programs → Texas Instruments → Hercules → HALCoGen 

 
•   Create a new project: 

• File → New → Project 

 

• For the TMS570 Kit:  
– Choose Family: TMS570LS04x 

– Device: TMS570LS0432PZ 

 

• For the RM4 Kit:  
– Choose Family: RM42x 

– Device: RM42L432PZ 

 

• Then define a name: ‘ADC’ 

• Location: “C:\myWorkspace” 

1 

4 

2 

3 



Driver Enable 

• Enable the SCI and ADC drivers in the ‘Driver Enable’ sub tab of the device  
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SCI Configuration 
 

• Select the SCI tab and then the “SCI/LIN Data Format” subtab 

• Ensure that the SCI module is setup with the following parameters: 
– Baud rate: 9600 

– Data bits: 8 

– Enable Parity (odd), 1 Stop bit 
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ADC Group Configuration 

• In the ‘ADC’ tab and ‘ADC1 Group 1’ Subtab, Configure FIFO Size, Trigger Source and 

ADC channel as shown below 

 

 

 

 

 

 

 

 

 

 

 

 

 

•  Generate code: File → Generate Code or click  
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Only one conversion per software trigger is done 

SW Trigger as Trigger Source 

Ambient light sensor is connected to MibADC1 Pin9  



MibADC Exercise 

• Insert the following code in the corresponding sections within the ‘sys_main.c’ file 

 

– USER CODE BEGIN (0) -  #include header section 
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/* USER CODE BEGIN (0) */ 

#include "sci.h" 

#include "adc.h" 

#include "stdlib.h" 

unsigned char command[8]; 

/* USER CODE END */ 



MibADC Exercise 

– USER CODE BEGIN(3) - Main() section 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

– Now build and load your program on the microcontroller 
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void main(void) 

{/* USER CODE BEGIN (3) */ 

  adcData_t adc_data; //ADC Data Structure 

  adcData_t *adc_data_ptr = &adc_data; //ADC Data Pointer 

  unsigned int NumberOfChars, value; //Declare variables 

 

  sciInit(); //Initializes the SCI (UART) module 

  adcInit(); //Initializes the ADC module 

 

  while(1)  // Loop to acquire and send ADC sample data via the SCI (UART) 

  { 

    adcStartConversion(adcREG1, 1U);  //Start ADC conversion 

    while(!adcIsConversionComplete(adcREG1, 1U)); //Wait for ADC conversion  

    adcGetData(adcREG1, 1U, adc_data_ptr); //Store conversion into ADC pointer 

    value = (unsigned int)adc_data_ptr->value; 

    NumberOfChars = ltoa(value,(char *)command); 

    sciSend(scilinREG, 2, (unsigned char *)"0x"); //Sends '0x' hex designation chars 

    sciSend(scilinREG, NumberOfChars, command); //Sends the ambient light sensor data 

    sciSend(scilinREG, 2, (unsigned char *)"\r\n"); //Sends new line character 

  } 

/* USER CODE END */} 



Testing your code 

• Upon completion open your preferred terminal program.  
– Note: A terminal program is included in CCS. To enable it go to ‘View’ -> Other and select 

‘Terminal’ from the ‘Show View’ menu. If the ‘Terminal’ option is not available it can be added as 

an eclipse plug-in by following these instructions: 

http://processors.wiki.ti.com/index.php/How_to_install_the_terminal_plugin_in_CCSv5  

 

• Setup  the terminal program with the following properties: 

– Baud rate: 9600 

– Data bits: 8 

– Odd parity, 1 Stop bit 
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• Click the ‘Run’ button to run the program 
 

  

  

 Now you should see the ADC results in the terminal program 

• Use a flashlight to change the light level supplied to the ambient light sensor on 

the board and notice the output values change in the terminal program. 

http://processors.wiki.ti.com/index.php/How_to_install_the_terminal_plugin_in_CCSv5


Enabling the CCS Terminal 

1) Select View → Other 

 

 

 

 

 

2) Then select ‘Terminal’ from the ‘Show 

View’ menu.  

 

3) Enter the proper communication 

settings for the ‘Terminal Tab’ 
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Additional Hercules™ Information 
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Additional Information 
Hercules Web Page: www.ti.com/hercules  

RM4 Web Page: www.ti.com/rm4 

TMS570 Web Page: www.ti.com/tms570 

TMS470M Web Page: www.ti.com/tms470m   
– Data Sheets 

– Technical Reference Manual 

– Application Notes 

– Software & Tools Downloads and Updates 

– Order Evaluation and Development Kits 

Engineer 2 Engineer Support Forum:  

www.ti.com/hercules-support  
– News and Announcements  

– Useful Links 

– Ask Technical Questions 

– Search for Technical Content 

Hercules WIKIs:  

RM4 WIKI: www.ti.com/hercules-rm4-wiki  

TMS570 WIKI: www.ti.com/hercules-tms570-wiki  

TMS470M WIKI: www.ti.com/hercules-tms470m-wiki   
– How to guides 

– Intro Videos 

– General Information 
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Want Additional Training? 

Safety Critical Design and Programming with Hercules™ Microcontrollers: 

Day 1 Day 2  Day 3 

• Welcome and Intro 

• Hercules™ Product Overview / MCU 

Roadmap    

• Safety Standards and Hercules 

Safety Features / Exercise 

•  HALCoGen / Exercise        

• Code Composer Studio / 

Demonstration 

• Compiler 

• Flash Overview 

• Flash Tools: nowFlash, nowECC / 

Exercise 

 

• Summary / Questions 

• ARM ® Cortex™ -R4F CPU 

• System Module Overview  

• Device setup/startup, Real Time 

Interrupt Module, Vectored 

Interrupt Manager  

• CRC Controller, CPU Compare 

Module, Error Signaling Module, 

Dual Clock Compare, JTAG 

Security Module   

• General Purpose I/Os / Exercise 

• Direct Memory Access Controller 

(DMA) 

• Serial Communication Interface 

(SCI/UART)  / Exercise 
 

• Summary / Questions 

• Multi-Buffer ADC (MIBADC) / 

Exercise  

• Multi-Buffer Serial Peripheral 

Interface (SPI / MIBSPI-P)  

• DCAN  

• FlexRay 

• External Memory Interface (EMIF) / 

Parameter Overlay Module (POM)  

• Ethernet 

• USB Host / Device 

• HET (High End Timer) IDE 

• N2HET & Transfer Unit / Exercise 

• Summary / Questions / Survey 

Hercules™ Training Videos: www.ti.com/herculestraining  

http://www.ti.com/herculestraining


Thank You! 
 

Please fill out the Training Class Survey 
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